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SECTION 1 .O

INTRODUCTION

The Decision Modeling System (DEMOS) is a computer tool used on the IVHS
Analysis and Design Contract (Task 1: Analysis of Goals, Functions, and Priorities)
t o :

1.) Display the goals-to-actions relationship structure and provide for future
expansion of data and analyses.

2.) Perform selected sensitivity analyses and estimate the potential
improvements of key IVHS actions (high payoff items).

This Appendix documents the details of the IVHS benefit analysis DEMOS models
and provides the PATH user information about what is contained in and how to use
the models.

It should be noted that the objective of this contract was to structure an approach to
evaluate the relationships of the top-level IVHS goals to the implementable actions
and then, where possible, to assess the relative benefits of those actions toward
accomplishing the goals. The results are not meant to be “the answer” but rather a
beginning at understanding the problem and a point of departure for further
analysis.

To this end, the DEMOS model has been used as a tool to analyze selected IVHS
actions with the goal of determining the key driving parameters through the use of
sensitivity analysis. The results of potential benefits of these actions are dictated by
the assumptions made and are not meant to represent the only answer. Our
recommendation is that PATH use the structure established in DEMOS to 1) assess
the benefits of the selected IVHS actions using their own assumptions, and 2)
further the benefits analysis for the other IVHS actions as yet not analyzed.

About DEMOS

The Decision Modeling System (DEMOS) is a general framework for constructing
analytical models which is currently implemented on a Macintosh computer system.
The key features of the software used in our activities include influence diagrams to
display the model structure, hierarchical structure to organize large models,
hypertext capability to allow “as you go” documentation, and array abstraction which
provides for multidimensional models. DEMOS is ideal for performing engineering
trade-off studies and sensitivity analysis on uncertain variables.

DEMOS has many other features, such as the ability to assign a probability
distribution to any variable, that were not used in our analyses, but could be useful
in future studies. For information regarding how to use DEMOS refer to Sections 3.0
and 4.0 of this Appendix.
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DEMOS IVHS Models Developed and Analyses Performed

Three DEMOS models were developed under this contract corresponding to the
IVHS scenarios evaluated. Within each of these models are the appropriate goals-
to-actions relationships discussed in Chapter 3.0 of the final report. In addition to
the goals-to-actions relationship structure, three separate analyses were developed
and are contained in the appropriate DEMOS models. The three DEMOS models
and the corresponding analyses conducted in each are as follows:

DEMOS MODELS ANALYSES PERFORMED

l Urban Freeways Vehicle Density Improvement, Safety
l Urban Arterials Intersection Queue Clearing, Safety
l Downtown Networks Safety

The safety analysis is the same in all three scenarios. The data was not in a form to
allow a scenario breakdown, therefore, the same information has been included in
each model.

Variables Used in Analyses and Resulting DEMOS Outputs

One of the key features of DEMOS is its ability to perform quick sensitivity studies of
all variables affecting a specific output to determine which are the driving
parameters. Each of the variables in the model can have multiple values allowing
these sensitivities to be performed easily.

The three analyses developed under this contract (freeway vehicle density
improvement, intersection queue clearing, and overall safety) are discussed below.
The input variables, the corresponding outputs, and key sensitivities developed in
the analyses using DEMOS are summarized.

Freeway Vehicle Density Improvement Analysis

The following are the input variables affecting the freeway vehicle density
improvement analysis:

l Speed
l Improved driver reaction time
l Deceleration rate of Car B

(fraction of car A)

l Current driver reaction time
l Deceleration rate of Car A
l Platoon size

l Intra-platoon spacing
l Car length
l Baseline traffic flow

l Space degradation factor
l Platoon size mix for multi-lanes

c-2



The following outputs can be obtained in the freeway vehicle density improvement
analysis as a function of the appropriate input variables (above):

l Safe braking distances required to avoid an accident
l Lane flow parametrics
l Gap holding lane flow estimates
l Gap holding vs Baseline lane flow estimates
l Platooning lane flow estimates
l Platooning vs Baseline lane flow estimates
l Platooning vs Gap holding vs Baseline ‘estimates for a 4 lane freeway

Some of the key sensitivities that impact lane flow that can be analyzed are:

l Relative braking capabilities of car A and car B
l Driver/Automated car reaction times
l Platoon sizes
l Intra-platoon spacing

Intersection Queue Clearing Analysis

The following are the input variables affecting the intersection queue clearing
analysis:

l Number of cars to be evaluated
l Space between cars when stopped
l Initial car delay time (automated)
l Steady state spacing (automated)
l Car length
l Time of a green light

l Constant acceleration rate
l Initial car delay time (manual)
l Steady state spacing (manual)
l Max. speed the cars can attain
l Distance the 1st car must travel

l Steady state spacing decay rate factor (manual only)

The following outputs can be obtained in the intersection queue clearing analysis as
a function of the appropriate input variables (above):

l Total distance required for all cars to travel
. Total time used due to spacing between the cars (manual and automated)
l Total time to clear the intersection (manual and automated)

How many cars can get through the intersection given a green light time
l ( manual and automated)

Some of the key sensitivities that impact the number of cars that can get through the
intersection are:

l Constant acceleration rate
l Steady state spacing
l Distance the first car must travel to clear the intersection
l Maximum speed
l Green light time
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Overall Safety Evaluation

The input variables affecting the overall safety evaluation are the current accident
data by crash severity and manner of collision provided by the General Estimates
System, Department of Transportation (1990), and the improvement factors
(assuming some level of automation implemented) which are applied to the current
data.

The outputs of the overall safety evaluation are the total accidents by severity of the
crash and manner of collision for both the current and the improved data, and the
percent improvement. The primary variables to be evaluated in this analysis are the
improvement factors.

Contents of This Appendix

Section 2.0 of this appendix displays the three DEMOS models. This includes the
printed DEMOS output for the entire model structure (screen by screen) and the
information related to each element or object of the model. The information includes
the name, a description, the definition (equations or values), the inputs, and the
outputs for each variable.

The specific output of the analyses including the estimates of potential
improvements due to implementation of a specific IVHS action and the sensitivity
analyses are not shown in this document. It is left to the user to exercise the models
for this information. A summary of the key results of the analyses are discussed in
Chapter 4.0 of the final report.

Sections 3.0 and 4.0 are the DEMOS Tutorial and Quick Reference Guide,
respectively. They are meant to provide the user with some important information
on how to use the DEMOS system.
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SECTION 2.0

DEMOS MODELS

This Section displays the following three DEMOS models:

l Urban Freeways
l Urban Arterials
l Downtown Networks

The models are displayed using the actual printed DEMOS outputs for the entire
model structure (screen by screen) and the information related to each element or
object of the model. The information includes the name, a description, the definition
(equations or values), the inputs, and the outputs for each variable.

The specific output of the analyses including the estimates of potential
improvements due to implementation of a specific IVHS action and the sensitivity
analyses are not shown in this document. It is left to the user to exercise the models
for this information. A summary of the key results of the analyses are discussed in
Chapter 4.0 of the final report.
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DEMOS MODEL

- URBAN FREEWAYS -
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( O b j e c t

T

i v e  B e n e f i t - i n c

itle: Benefit-
Increasing Normal
Capacity

Units:

Description: Evaluate the benefits of increasing the normal vehicle capacity by keeping
vehicle density in stable flow region, homogenizing the density, or
increasing the safe speed for a given density.

Definition:

I n puts : ( Estimate-... estimate of homogenized density

0
( Estimate-sfb estimate of stable flow . . .

G
( Vehdens Vehicle Density- % improve...



( O b j e c t i v e  B e n e f i t - m Units:

Title: Benefit-
Matching Usage
to Capacity

Description: Evaluate the benefits of matching usage to capacity by constaining the
entry to the system and reducing and reshaping the usage.

#r
Definition: (Benefit-of+Selective-)

Encouraae
Provided t-
Route-guid

Inputs: 0 Benefit-of Benefit of Ramp Metering
( Encourage- Encourage Mode Shift
( Provided-t Provided Traveler Information
( Routeguid  Route Guidance
( Selective- Selective Road Pricing



( O b j e c t i v e  B e n e f i t - a Units:

Title: Benefit-
Allevtg Accident,
incident

Description: Evaluate the benefits of alleviating accidents and incidents on congestion
by reduced frequency of accidents, rerouted and detoured vehicles, and
through rapid respnse and clean-up activities.

Definition:1 Benefit of11
Benefit of2-
Benefit of4

Inputs: ( Benefit-of1 Benefiiof ReducedAccidents
( Benefit-of2 Benefit of Rapid Response, etc
( Benefit-of4 Benefit of Reroute, Deto...
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Dlndex  Speed

Title: speed

Units: MPH

Description: Index of speeds to be used for evaluation of vehicle density analyses

Fqv‘I
Definition: Sequence(0,7)*10

outputs: Braking Distance- current RT



ulndex Reaction-tim

Tit I e : Reaction Time-
current

Units: seconds

Description: An index of possible reaction times that a driver of a following vehicle
would exhibit before applying his/her brakes after a front car brakes.
This index is for the current situation on the freeways.

Definition:

0utputs:l Braking Distance- current RT V



ulndex ReactionJi2

Tit I e : Reaction Time-
improved

Units: seconds

Description: An index of possible reaction times that a driver of a following vehicle
would exhibit before applying his/her brakes after a front car brakes.
This index is for an automated case (both gap holding and platooning).

El7
Definition:1

outputs: Braking Distance- improved RT V



ulndex

Title:

Description:

Definition:

Units: feetIntra-platoo

lntra platoon
spacing

The space that would exist between cars within a platoon.

IElr
3
5

10
15

Outputs:1 Vehicle Density- % improvement vI



oindex Cars-per-pla

Title: Cars Per
Platoon

Units: number

Description: Number of cars within a platoon to be evaluated.

Definition:

outputs: Vehicle Density- % improvement



( O b j e c t

T

Descript

Definit

Units: percentageve Vehdens

t I e : Vehicle Density-
% improvement

on: Calculate the increase (as a %) in vehicle density due to various IVHS
functions being implemented.

on: Platooning~[Intraglatoo=Input_platoo, Carsger_pla=Input ci-
Gap-holdinl[Gap-holding-=Input  I-

Inputs: D Cars-per-pla Cars Per Platoon
( Gap-holdinl Gap Holding % improve...
( Gap-holding- Gap Holding Reaction Ti...
(1 Input-cars- Input-cars/ platoon
0 lnputglatoo Input-platoon spacing
0 Input-rt-wi  Input- RT with Gap HOI...
D lntraglatoo lntra platoon spacing
0 Platooning- Platooning- % improve...

outputs: Benefit- Increasing Normal C a p a c i t y  V



IDecision Input--rt-wi

Title: Input- FIT  with
Gap Holding

Units: seconds

Description: Reaction time for the Gap Holding case to brake in an emergency. User
can input 0.1, 0.2, 0.3, 0.4, or 0.5 seconds.

wrv
Definition: 0.3

outputs: Vehicle Density- % improvement



. .

.-
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0 Decision I n p u t - c a r s -

Title: Input-cars/
platoon

Units: number

Description: The number of cars within a platoon on average. User can input 2, 3, 4,
5, 10, 15, or 20.

w-‘I
Definition: 3

outputs: Vehicle Density- % improvement



0 Chance Lane-holdi

Title: Lane Holding,
Changing

Units:

Description: Lane holding and changing is a key element of an implemented automatic
system on the freeways, however, it does not directly effect vehicle
density by itself. It has strong safety implications and is addressed in the
safety section of the model. It is shown here only for completeness.

ewv
Definition: 0



Diagram l Reaction Time Improvement

Lane flow
i:p:i:i:i$#;#i::::::::::: . . . . . .

parametrics I~.~.~.~.~.~.~.~.~.~.; ._._._._._._._....*.
. . . . . . . . . . . . . . . . . :.:.:.:‘:‘::::::::::::::::::::::::::::::::::::::::::.:~:~:~:~:$~. . . . . . . . . . . . . . . . . . . A’..........:.:.:..,:.:.:.:.:*:.:.:.:.:.:.:.:.:*:..:  . . . . . . . . ..:.:.:.:.:.:*:.:.:.:.::::::::::.~.~.~.~.~

Baseline Lane
Flow - current
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0 Chance Decel-rate-l

Title: Decel rate-
car B

Units: feet/sec/sec

Description: The deceleration rate of a following car. Current baseline is 90% of the
front car’s braking capability.

fVT
Definition: Decel-rate-*Decel-rate

1 npu t s : ( Decel-rate Decel rate fraction (B of A)
( Decel-rate- Decel rate- car A

outputs: Braking Distance- current RT V

?
R



( C h a n c e

Title:

Description:

Units:Decel-rate

Decel rate
fraction (B of A)

This is the fraction that the deceleration rate of car B ( the following car)
is of car A. For instance, if car A car brake at 0.8g’s,  then car B can
brake at 90%, 80%, or 70% of that value. The baseline value is 90%.

Definition:

Outputs:1 Decel rate- car B



0 Chance Braking-dist

Tit I e : Braking Distance-
current RT

Units: feet

Description: This block provides input data regarding the distance apart two cars on a
freeway need to be travelling to avoid a collision. It varies by speed of the
car from 0 to 70 and is provided for various reaction times of each of the
cars. This data is for the current highway situation. The data can be
generated for various stopping rates of both cars.

fqvV
Definition: (((Speed*Speed*2.151  111111)/2)*((1/Decel~rate_l)-(l/Decel_ra

te-)))+Speed*l.466666667*ReactionWtim

t nputs:  ( Decel-rate-l  Decel rate- car B
( Decel-rate- Decel rate- car A
D ReactionJim Reaction Time- current
uspeed speed



0 Chance Braking-disl

Tit I e : Braking Distance-
improved RT

Units: feet

Description: This block provides input data regarding the distance apart two cars on a
freeway need to be travetling to avoid a collision. It varies by speed of the
car from 0 to 70 and is provided for various reaction times of each of the
cars. This data is for the improved reaction times situation on the
highway. The data can be generated for various stopping rates of each car.

T-v
Definition: (((Speed’Speed*2.151111111)/2)*((1/DeceI~rate~1)-(1/Decel~ra

te-)))+Speed*l.466666667’ReactionVti2

f nputs: ( Decel-rate-l Decel rate- car B
( Decel-rate- Decel rate- car A
D Reaction-ti2 Reaction Time- improved
Dspeed speed

Outputs:1  L a n e  f l o w  parametrics v I



0 Chance Lane-flow-pa

Title: Lane flow
parametrics

Units: Cars per hour

. Description: Estimate the lane flow capabilities for various reaction times at various
speeds.

F-WV
Definition: ((Speed*5280)*Degradatio)/(  Car-length+Braking-disl)

Inputs: ( Braking-disl Braking Distance- imp...
( Car-length Car Length
( Degradatio Degradation factor
c7speed speed



0 Chance Car-length

Title: Car Length

Units: Feet

Description: The assumed length of one car.

w-~
Definition: 18

Outputs:/  Lane f low parametrics



0 Chance Degradatio

Tit I e : Degradation
factor

Units: Factor

Description: This is a factor that represents a degradation in freeway space available
to accommodate more vehicles due to the space required for cars to enter
and exit gap held or platooning cars. The baseline is 0.85, which equates
to a 15% reduction in space available.

evr
Definition: 0.85

Outputs:/ L a n e  f l o w  parametrics  V



0 Chance Baseline-b

Tit I e : Baseline Braking
Dist. - current

Units: Feet

Description: This is our assumed safe braking distance for the current driver. it
approximately matches the Highway capacity manual. It assumes a lg
stop of a front car, a 0.7 set reaction time, and a 0.59 stopping capability
of the following car.

w-v
Definition: (((Speed*Speed*2.151  1111 11)/2)*((1/19.2)-(1/28.8)))+Speed*

1.466666667*1 .O

outputs: Baseline Lane Flow - current V



0 Chance Baseline-l

Tit I e : Baseline Lane
Flow - current

Units:

Description: Using the safe braking distance generated by the previous block, this
block estimates the lane flow capability for the current conditions. This
is an important variable because it is used for comparison purposes when
evaluating the % improvement that could be realized through the various
levels of automation.

Definition: (Speed*5280)/(  Car-length+Baseline-b)

Inputs: ( Baseline-b Baseline Braking Dist. - cur...
( Car-length Car Length

0
Dspeed speed

g outputs: Platooning- % improvement
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0 Chance Gap-holding-

T i t I e : Gap Holding
Reaction Times

Units: seconds

Description: The automatic reaction times of a Gap Holding system to be evaluated.

iz3v
Definition:1

Outputs:1  Vehicle Density- % improvement v



0 Chance Braking-dis2

Title: Braking Distance-
w/ GH

Units: feet

Description: This input block provides input data regarding the distance apart two cars
on a freeway need to be travelling  to avoid a collision. It varies by speed
of the car from 0 to 70 and is provided for various reaction times of each
of the cars. This data represents gap holding being implemented on a car
in the highway situation. The data can be generated for various stopping
rates of each car. See the reaction time inprovement block for some of
the data.

Definition: (((Speed*Speed’2.151111111)/2)*((1/Decel~rate_1  [Decel-rate=O.
9])-( l/Decel-rate-)))+Speed*l.466666667*Gap-holding-

t n p u t s : ( Decel-rate Decel rate fraction (B of A)
( Decelerate-l  Decel rate- car B
( Decel-rate- Decel rate- car A
( Gap-holding- Gap Holding Reaction Ti...
Dspeed  speed

oUtPUts: Lane Flow est imates V 1



( C h a n c e Lane-flow-es

Title : Lane Flow estimates

Units: cars per hour

Description: Estimate the lane flow values in cars per hour for the Gap Holding case
for various reaction times.

pwr
Definition: ((Speed*5280)*Degradatio)/(Car_length+Braking_dis2)

l npu tS : ( Braking-dis2 Braking Distance- w/ GH
( Car-length Car Length
( Degradatio Degradation factor
uspeed speed

outputs: Trade comparison to GH and baseline V



0 Chance Degradatio

Tit I e : Degradation
factor

Units: Factor

Description: This is a factor that represents a degradation in freeway space available
to accommodate more vehicles due to the space required for cars to enter
and exit gap held or platooning cars. The baseline is 0.85, which equates
to a 15% reduction in space available.

v-r
Definition: 0.85

OUtpUtS:1  Lane flow parametrics  7



0 Chance

Title:

Description:

Gap-holdin

Gap Holding
v s .  current-
lane flow

Units:

This compares total lane flow for Gap Holding and the current condition.
Currently, the gap holding case represents an 0.3 set reaction time.

Definition: Lane~flow~es[Gap~holding_=0.31
Baseline 1

Inputs: ( Baseline-l Baseline Lane Flow - current
( Gap-holding- Gap Holding Reaction Ti...
( Lane-flow-es Lane Flow estimates



0 Chance Lane-flow-

Title: Lane flow
differences

Units: Cars per hour

Description: This variable is the result of subtracting the lane flows for various gap
holding reaction times from the baseline lane flows. This is an
intermediate step to calculate the % improvement of gap holding over
current conditions.

Definition: Lane-flow-es-Baseline-l

Inputs: ( Baseline-l Baseline Lane Flow - current
( Lane-flow-es Lane Flow estimates

outputs: Gap Holding % improvement V



( C h a n c e Gap-holdinl

Title: Gap Holding
% improvement

U n i t s : Percentage

Description: This calculates the % lane flow improvement of gap holding over current
lane flows.

v-r
Definition: (Lane~flow~/Baseline~l)‘100

Inputs: ( Baseline-l Baseline Lane Flow - current
( Lane-flow- Lane flow differences

outputs: Vehicle Density- % improvement



0 Chance Baseline-l

Title: Baseline Lane
Flow - current

Units:

Description: Using the safe braking distance generated by the previous block, this
block estimates the lane flow capability for the current conditions. This
is an important variable because it is used for comparison purposes when
evaluating the % improvement that could be realized through the various
levels of automation.

pwr
Definition: (Speed”5280)/( Car-length+Baseline-b)

Inputs: ( Baseline-b Baseline Braking Dist. - curr...
( Car-length Car Length
Dspeed speed

outputs:



.
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0 Chance Lane-flow Units: Cars per hour

Title: Lane Flow
-Platooning

Description: Calculate the lane flow of platooned cars as a function of speed, number of
cars in the platoon, and intra-platoon spacing. This assumes that gap
holding is in place and therefore automatic braking is implemented. A
factor of 15% degradation is being used to account for ineffecient  lane
changing issues.

Definition: (Speed*5280*Degradatio)/((Cars_per_pla*Car_length+((Cars_per_p
la-l)*lntra-platoo)+Braking_Disl  [Reaction-ti2=0.1  ,Decel-rate=0.9]
) /Cars -per -p la )

Inputs: ( Braking-disl Braking Distance- imp...
D Cars-per-pla Cars Per Platoon
( Car-length Car Length
( Decel-rate Decel  rate fraction (B of A)
( Degradatio Degradation factor
D lntraglatoo lntra platoon spacing
D ReactionJi2  Reaction Time- improved
L7speed  speed

Outputs:1 Traffic flow trade study- plato’ng 4



( C h a n c e Lane-f low-l

Title: Lane flow
differences

Units:

Description: This variable is the result of subtracting the lane flows for various
platooning conditions from the baseline lane flows. This is an
intermediate step to calculate the % improvement of platooning over
current conditions.

fqvV
Definition: Lane-Flow-Baseline-l

I n p u t s : ( Baseline-l Baseline Lane Flow - current
( Lane-flow Lane Flow -Platooning

outputs:



( C h a n c e Platooning-

Title : Platooning-
% improvement

U nits : percentage

Description: Calculate the % improvement of platooning over the current baseline lane
flows.

ewr
Definition: (Lane~flow~l/Baseline~l)*lOO

lnpu  ts: ( Baseline-l Baseline Lane Flow - current
( Lane-flow-l Lane flow differences

outputs: Vehicle Density- % improvement v



( C h a n c e

Title:

Description:

Platooning3 Units: Cars per hour

Platooning vs
Gap Hold’g- lane flow

A graph of lane flow comparisons between Gap Holding and platooning. The
Gap Holding line represents a 0.3 set reaction time. The platooning line
represents a 5 car platoon with each car 3 feet apart.

Definition:

Inputs: a Cars-per-pla Cars Per Platoon
( Gap-holding- Gap Holding Reaction Ti...
D Intraglatoo lntra platoon spacing
( Lane-flow Lane Flow -Platooning
( Lane-flow-es Lane Flow estimates



0 Chance

Title:

Description:

Platooningl

Platooning vs.
current- lane flow

Units: Cars per hour

A graph of lane flow comparisons between the current baseline and
platooning. The platooning line represents a 3 car platoon with each car
3 feet apart.

Definition: Lane~flow[Intraglatoo=lO,  Carsger_pla=3]
Baseline 1

lnpu ts: ( Baseline-l Baseline Lane Flow - current
D Cars-per-pla Cars Per Platoon
127 lntraglatoo lntra platoon spacing
( Lane-flow Lane Flow -Platooning



0 Chance Traffic-flow

Title: Traffic flow
trade study-

plato’ng

Units: Cars per hour

Description: Evaluate the traffic flow (multiple lanes) of platooning in a 4 lane
freeway assuming a certain percentage of time an average size platoon
would exist in each lane.

fQvT
Definition: Sum(Sum((Lane_flow[lntra_platoo=lO]*A_of_cars_),Lanes),Cars_per

-pIa)

l n p u t s : ( A-of-cars- % of cars per platoon per lane
D Cars-per-pla Cars Per Platoon
D Intraglatoo lntra platoon spacing
u Lanes Lanes
( Lane-flow Lane Flow -Platooning

Outputs:l  Trade comparison to GH and baseline V 1



0 Chance A-of -cars - Units: Percentage

Title: % of cars per
platoon per lane

Description: This tabular data provides the assumptions of what percentage of cars per
platoon would be reprented in each lane to be used in the traffic flow trade
study of a 4 lane freeway.

Definition: [ Edit Table Iindexed by Cars Per Platoon, Lanes

Inputs: D Cars-per-pla Cars Per Platoon
u Lanes Lanes

Traffic flow trade study- plato’ng V



Lanes Units: Text

Title: Lanes

Description: This is an index of lanes to be used in the traffic flow trade study of 4
lanes.

Definition:

'lane 3'
'lane 4’

outputs:



0 Chance

T i t l e :

Description:

Units: Cars per hourParametric-2

Trade comparison
to GH and baseline

Compare the platooning traffic flow trade results with 4 lanes of cars Gap
Holding and 4 lanes of cars in the current baseline condition. The Gap
Holding line assumes an 0.3 set reaction time.

#r
Definition: Traffic-flow

(Lane~flow~es[Gap~holding~=0.~1*4)

I (Baseline_l*4)1

I n p u t s : ( Baseline-l Baseline Lane Flow - current
( Gap-holding- Gap Holding Reaction Ti...
( Lane-flow-es Lane Flow estimates
( Traffic-f low Traffic flow trade study- plat...



0 Chance Estimate-r0 Units:

Tit I e : estimate of
homogenized density

Description: Refer to the final report for any information in this IVHS benefit analysis
category.

pwr
Definition: 0

outputs: Benefit- Increasing Normal C a p a c i t y  v
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0 Chance Estimate-sfb

Title: estimate
of stable flow
benefit

Units:

Description: Refer to the final report for any information in this IVHS benefit analysis
category.

B’I
Definition: Benefit-of

Mod-safega

Inputs: ( Benefit-of Benefit of Ramp Metering
( Mod-safega Mod safegap to incr. stable reg...



0 Chance Benefit-of Units:

Title : Benefit of Ramp Metering

Description: Refer to the final report for any information in this IVHS benefit analysis
category.

cwv
Definition: 0

outputs: estimate of stable flow benefit
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0 Chance Route_guid

Title: Route
Guidance

Units:

Description: Refer to the final report for any information in this IVHS benefit analysis
category.

pqvv
Definition: 0

outputs: Benefit- Matching Usage to Capacity



( C h a n c e Provided-t

Tit I e : Provided Traveler
Information

Units:

Description: Refer to the final report for any information in this IVHS benefit analysis
category.

v-r
Definition: 0

outputs: Benefit- Matching Usage to Capacity



0 Chance Selective-

Title: Selective
Road Pricing

Units:

Description: Refer to the final report for any information in this IVHS benefit analysis
category.

fWV
Def in i t ion:  0

outputs: Benefit- Matching Usage to Capacity



0 Chance Encourage-

Title: Encourage
Mode Shift

Units:

Description: Refer to the final report for any information in this IVHS benefit analysis
category.

fwr
Definition: 0



0 Chance Benefit-of1

Title: Benefit of
Reduced Accidents

Units:

Description: Refer to the final report for any information in this IVHS benefit analysis
category; Also some useful information can be found in DEMOS under the
safety IVHS goal (overall safety analysis).

w-r
Definition: 0

Outputs:[ Benefit- Allevtg Accident, Incident v



0 Chance Benefit-of2

Title: Benefit of
Rapid Response, etc

Units:

Description : Refer to the final report for any information in this IVHS benefit analysis
category.

fwr
Definition: 0

outputs: Benefit- Allevtg Accident, Incident



0 Chance Benefit-of4

Title: Benefit of
Reroute, Detour

Units:

Description: Refer to the final report for any information in this IVHS benefit analysis
category.

fwr
Definition: 0

outputs: Benefit- Allevtg Accident, Incident v



.
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0 Chance Lane-holdil

Title: Lane Holding

Units:

Description: Refer to the final report for any information in this IVHS benefit analysis
category.

pwv
Definition: 0



( O b j e c t i v e  Benefit-m2

Title: Benefit-
Mitigate Effects
of Accdnts

Units:

Description: Evaluate the benefit of mitigated effects of accidents. Refer to the final
report for any information in this IVHS benefit analysis category.

WV-~
Definition: Speed-care

Inputs: ( Speed-care Speed Care for Injured 1



0
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0 Chance Evaluate-g Units:

Tit I e : Evaluate gap control
(safety)

Description: This parameter is a function of the data presented in the overall Safety
evaluation. Gap control would impact the ‘angle’ and ‘sideswipe’ accident
types. In this case we have decided to average the estimated benefit of
each. Remember, this data is for freeway and arterials and is not divided
for our analysis.

ww-r
Definition: (((Current-to[Manner-of-=‘Angle’]+Current-to[Manner-of-=‘Sideswi

pe’])-(Improved-t[Manner-of-= ‘Angle’]+lmproved-t[Manner-of-=‘Sid
eswipe’]))/(Current_to[Manner_of_=’Angle’]+Current_to[Manner_of_
=‘Sideswipe’]))*lOO

0
2:

Inputs: ( Current-to Current Total Accidents by Ma...
( Improved-t Improved Tot Accidents by Ma...
UManner-o... Manner of Collision

outputs: Benefit- Reduce Freq of Accidents



0 Chance Evaluate-l Units:

Tit I e : Evaluate lateral
threat response

Description: This parameter is a function of the data presented in the overall Safety
evaluation. lateral threat response would impact the ‘rear-end’ and
‘Head-on’ accident types. In this case we have decided to average the
estimated the benefit of each. Remember, this data is for freeway and
arterials and is not divided for our analysis.

ewv
Definition: (((Current-to[Manner-of-=‘Rear-end’]+Current-to[Manner-of-=’Hea

d-on’])-(lmprovedJ[Manner-of-= ‘Rear-end’]+lmproved-t[Manner-of
=‘Head-on’]))/(Current_to[Manner_of-=’Rear-end’]+Current_to[Mar

ner-of--‘Head-on’]))*1  00

Inputs: ( Current-to Current Total Accidents by Ma...
( Improved-t Improved Tot Accidents by Ma...

UM anner-o... Manner of Collision

outputs: Benefit- Reduce Freq of Accidents v
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( O b j e c t i v e  Important- Units:

Title: Important: Read this box

Description: The information in this diagram represents a safety analysis on data from
1990. The current data was not divided among our senarios (Freeway,
Arterials, etc.) and there was no acceptable way to break it down.
Therefore, the data used in this analysis is a total of accidents on the
freeway and arterials/networks. The information will be repeated in
other DEMOS models for completeness.

fWV
Definition: Improve-si

Inputs: ( Improve-si Improve Situation Assessment...



ulndex Crash-seve Units: Type

Title: Crash
Severity

Description: The index of crash severities as used by the 1990 General Estimates
System of the . . . . . These severities range from property damage only,
to minor or moderate injury, to severe or fatal injury.

Definition: 'Property damage only'
'Minor or moderate injury'

I 'Severe or fatal injury'

outputs: Current Accident data (1990)

?
3



ulndex Crash-seve

Title: Crash
Severity

Units: Type

Description: The index of crash severities as used by the 1990 General Estimates
System, Department of Transportation. These severities range from
property damage only, to minor or moderate injury, to severe or fatal
injury.

Definition: 'Property damage only'
'Minor or moderate injury'

'Severe or fatal injury'

Outputs:l Current Accident data (1990) v



ulndex Manner-of- Units: Type

Title: Manner of
Collision

Description: This is the index of the manners of collision. This includes angle,
rear-end, head-on, and sideswipe collisions.

#r
Definition: 'Angle'

'Rear-end'
'Head-on'

'Sideswipe'

Outputs:l  Evaluate gap control (safety)



( C h a n c e Current-ac

Title: Current Accident
data (1990)

U nits : Number of accidents

Description: This is the current (1990) multi-vehicle crashes by manner of collision
and crash severity. The data source is the General Estimates System
(1990) published by the Department of Transportation, National
Highway Traffic Safety Administration.

Definit ion: (Edit]  indexed by Crash Severity,  Manner of Coll ision

Inputs: 0 Crash-seve Crash Severity
UManner-o... Manner of Collision

Outwts:l Current Total Accidents bv Manner v 1



0 Chance Current-to

Tit I e : Current Total Accidents
by Manner

Units: Number of accidents

Description: This sums up the total accidents by manner of collision. Using the
current data.

rwr
Definition: Sum((Current-ac),Crash-seve)

Inputs: D Crash-seve Crash Severity
( Current-ac Current Accident data (1990)

outputs: Evaluate gap control (safety)



0 Chance Current-to1 Units: Number of accidents

Tit I e : Current Total Accidents
by Severity

Description: This sums up the total accidents by crash severity. Using the current
data.

pwr
Definition: Sum((Current-ac),Manner-of-)

Inputs: ( Current-ac Current Accident data (1990)
UManner-o... Manner of Collision

outputs:



0 Chance lntermedia

Title: Intermediate
Step 1

Units:

Description: This is an intermediate step to derive the Improved accident data.

mr
Def i n i t lo n :  ( E d i t ]i n d e x e d  b y  C r a s h  S e v e r i t y ,  M a n n e r  o f  C o l l i s i o n

Inputs: D Crash-seve Crash Severity
( Current-ac Current Accident data (1990)
( Factors-2 Factors 2
UManner-o... Manner of Collision



0 Chance Factors-2

Title: Factors 2

Units: Factor

Description: These factors are the percentages of the severe or fatal category that
through automation are moved downward in category. For instance, 30%
of the severe or fatal angle accidents will become minor or moderate
accidents, and so forth.

Definition : (Edit) indexed by Crash Severity, Manner of Collision

Inputs: D Crash-seve Crash Severity
DManner-o... Manner of Collision

Outputs:l  Intermediate Step 1 v 1



0 Chance Intermedial Units:

Title: Intermediate
Step 2

Description: This is an intermediate step to derive the Improved accident data.

Definition: (Edit] indexed by Crash Severity, Manner of Collision

Inputs: D Crash-seve Crash Severity
( Current-ac Current Accident data (1990)
( Factors-3 Factors 3
DManner-o... Manner of Collision

outputs: Improved Accident Data wl Autom.



0 Chance Factors-3

Title: Factors 3

Units: Factor

Description: These factors are the percentages of the minor or moderate injury
category that through automation are moved downward in category to
property damage only. For instance,lO%  of the minor or moderate
injury angle accidents will become property damage only accidents, and
so forth.

Definition : (Edit] indexed by Crash Severity, Manner of Collision

Inputs:  D Crash-seve Crash Severity
L7M anner-o... Manner of Collision

outputs: Intermediate Step 2
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0 Chance

Title:

Description:

Definition:

Inputs:

Factors-l Units: Factor

Factors 1

These are the improvement factors applied to the current accident data to
develop one element of the improved accident data. There is a factor for
each manner and severity of accident. These factors are the fraction
which remain in that category. In others words, they are the percentages
of each category that automation can’t do anything about.

mr
[Edit] indexed by Crash Severity, Manner of Collision

D Crash-seve Crash Severity
OManner-o... Manner of Collision

outputs: Improved Accident Data wl Autom.
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0 Chance Improved-t1 Units: Number of accidents

Tit I e : Improved Tot Accident
by Severity

Description: This sums up the total accidents by crash severity. Using the improved
data.

v-r
Definition: Sum((lmproved-a),Manner-of-)

Inputs:  ( Improved-a Improved Accident Data w/Au...
UManner-o... Manner of Collision

outputs: % Improved- Accidents by Severity v



0 Chance A-improved U nits : Percentage

Title: % Improved-
Accidents by Manner

Description: This calculates the % improvement that is achieved through automation
by manner of collision.

wrr
Definition: ( (Current-to- Improved-t) /Current-to)*100

Inputs: ( Current-to Current Total Accidents by Ma...
( Improved-t Improved Tot Accidents by Ma...



( C h a n c e A-improved1

Title: % Improved-
Accidents by Severity

Units: Percentage

Description: This calculates the % improvement that is achieved through automation
by crash severity.

wrv
Definition: ((Current-tol-Improved~tl)/Current~tol)*lOO

Inputs: ( Current-to1 Current Total Accidents by Se...
( Improved-t1 Improved Tot Accident by Seve...



0 Chance I mprove-si

Tit I e : Improve Situation
Assessment (veh)

Units:

Description: This parameter is the beginning of making something happening. It has no
impact unless because of assessing the situation you decide to do
something about it. Therefore, this is an input to the overall Safety
evaluation as shown.

pwv
Definition: 0

outputs: Important: Read this box v





0 Chance Impact-of- Units:

Title: Impact of decreasing
accel & decel

Description: Refer to the final report for any information in this IVHS benefit analysis
category.

w--
Definition: 0



0 Chance

Title:

Description:

Units:Impact-of- l

Impact of reducing
veh miles traveld

Refer to the final report for any information in this IVHS benefit analysis
category.

Definition: Influence-
Influence 1

1 nputs: ( Influence- Influence of route guidance
( Influence... Influence of encouraged mode  . . .



0 Chance Influence-

Title: Influence of
route guidance

Units:

Description: Refer to the final report for any information in this IVHS benefit analysis
category.

pwr
Definition: 0

outputs: Impact of reducing veh miles traveld V



0 Chance Influence-l

Title: Influence of
encouraged mode shift

Units:

Description: Refer to the final report for any information in this IVHS benefit analysis
category.

vrr
Definition: 0

outputs: Impact of reducing veh miles traveld
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( O b j e c t i v e

Title:

Description:

B e n e f i t - m

Benefit-
Managing Vehicle
Density

Units:

Documents the benefit of managing vehicular density on major arterials.

#r
Definition: Encour mod

Gap-contra
Platooning

Gap-control
Modify-saf

I n p u t s :  ( Encour-... Encourage Mode Shift
( Gap-contra Gap Control
( Gap-control Gap Control
( Modify-saf Modify Safegap Function
( Platooning Platooning



( O b j e c t i v e  B e n e f i t - i Units:

Title: Benefit-
Increasing intersct’n flow

Description: Documents the benefit of Increasing intersection flow on arterials.

#r
Definition:

Compare-ma

Inputs:  0 Compare-ma Compare manual and Au...
( Enable-hig Enable Higher Density Veh. Flow
( Interleave Interleave Intersection Traffic



( O b j e c t i v e

Title:

Description:

Units:B e n e f i t - a

Benefit-
Allevtg Accident,
Incident

Documents the benefit of alleviating accidents and incidents.

#r
Definition: Estimate-r

Estimate-r1
Estimate r2

Inputs: ( Estimate-r Estimate Reducing Freqof Ace...
( Estimate-r1 Estimate Rapid Reponse,Clean...
( Estimate-r2 Estimate Reroute, Detour



Diagram l Incr. Safe Speed for Giv’n density



0 Chance Gap-contra

Title: Gq
Control

Units:

Description: Refer to the final report regarding any information in this IVHS benefit
analysis category.

WV-v
Definition: 0

outputs: Benefit- Managing Vehicle



0 Chance Platooning

Title: Platooning

Units:

Description: Refer to the final report regarding any information in this IVHS benefit
analysis category.

w-~
Definition: 0

outputs: Benefit- Managing Vehicle
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Diagram l Keep Density in Stable flow



0 Chance Gap-control

Title: Gap Control

Units:

Description: Refer to the final report regarding any information in this IVHS benefit
analysis category.

w-r
Definition: 0

outputs:



( C h a n c e Modify-saf

T i t I e : Modify Safegap
Function

Units:

Description: Refer to the final report regarding any information in this IVHS benefit
analysis category.

pwr
Definition: 0
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ulndex Total-numb Units: Number

Title: Total Number of
cars to be evaluated

Description: This is the total number of cars that will be evaluated to get through the
intersection.

pwr
Definition: Sequence(l,60)*1

Outputs:1 Calc. the total distance requir’d



0 Chance Space-betw Units: feet

T i t I e : Space between cars
when stopped

Description: This is the space between each car when stopped at an intersection waiting
for the light to turn green.

Definition: 4

outputs: Calc. the total distance requir’d



ODecision Steady-sta

Tit I e : Steady State Spacing
decay rate

Units: constant

Description: This is a constant to represent the decay rate that impacts the steady state
spacing of cars as they begin to move through the intersection.

evr
Definition: 2.0

outputs: Calc. the total time due to spa&g-M



0 Chance Initial-ca

Title: Initial Car delay-
manual

Units: seconds

Description: This is the time (seconds) that the first car delays before entering
intersection after the light turns green. It represents the manual driver.

pvv
Definition: 3.5

outputs: Calc. the total time due to spac’g-M



0 Chance Initial-Cal

Title: Initial Car delay-
automated

Units: seconds

Description: This is the time (seconds) that the first car delays before entering
intersection after the light turns green. It represents the automated case.

v-7
Definition: 0.1

outputs: Calc. the total time due to spa&g-A 7



0 Chance Steady-stal Units: seconds

Title: Steady State Spacing-
Manual

Description: This is the spacing that the cars would attain when beginning to clear an
intersection after the light turns green. It represents the manual driver.

Definition:

outputs: Calc. the total time due to spac’g-M V



( C h a n c e

Title:

Description:

Units: secondsSteady-sta2

Steady State Spacing-
Automated

This is the spacing that the cars would attain when beginning to clear an
intersection after the light turns green. It represents the automated case.

liEI7
Definition:

outputs: 1 Cab. the total time due to spac’g-A v



0 Chance Car-length

Title: Car Length

Units: feet

Description: The length of a car.

pwv
Definition: 1 5

outputs: Calc. the total distance requir’d V



0 Chance Max-speed

Title: MaxSpeed

U nits : feet per second

Description: The maximum speed that a car is allowed to attain progressing through an
intersection. The baseline is 30 MPH or 44 feet per second.

WV-~
Definition: 30.0”1.466666

CutPutS:[  Est. total time to clear intrsct’n-M V 1
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0 Chance Accelerati

Tit I e : Acceleration

U nits : feetkeckec

Description: This is the acceleration that the car exhibits as it moves through the
intersection. We are using 0.15g’s or 4.8feet per second per second.

w-r
Definition: 0.15*32

outputs: Est. total time to clear intrsct’n-M V



( C h a n c e T i m e - o f - g Units: seconds

Title: Time of
Green Light

Description: This is the time that the intersection light is green and therefore the cars
can progress through the intersection. We have choosen  to evaluate a
range of 20 to 60 seconds.

Definition:

I 60

outputs: Est. how many cars thru green It-M V



( C h a n c e Calc.-the- Units: feet

Title: Calc. the total
distance requir’d

Description: This is the total distance required to clear all of the cars through the
intersection.

WV-~
Definition: (Distance_l+((Total_numb-l)*(Car_length+Space_betw)))

Inputs:  ( Car-length Car Length
( Distance-l Distance 1st car must travel
( Space-betw Space between cars when stop...
0 Total-numb Total Number of cars to be eva...

outputs: Est. total time to clear intrsct’n-M 7



( C h a n c e Calc-the-2

Title: Calc. the total
time due to spac’g-M

Units: seconds

Description: This is the total time used due to the spacing required between cars as
they move through the intersection. It includes a decay rate function to
represent that cars in the front of the queue allow more spacing than the
cars at the end of the line. This is for the manual driver.

w-v
Definition: If

Total-numb=1
then Initial-ca
Else
Cumulate((Steady~sta1+(Initial~ca/(Total~numbASteady~sta))),Total~
numb)

Inputs: ( Initial-ca Initial Car delay- manual
0 Steady-sta Steady State Spacing decay rate
( Steady-St... Steady State Spacing- Manual
0 Total-numb Total Number of cars to be eva...

outputs: Est. total time to clear intrsct’n-M V



( C h a n c e Calc-the-1

Title: Calc. the total
time due to spac’g-A

Units:

Description : This is the total time used due to the spacing required between cars as
they move through the intersection. It includes a decay rate function to
represent that cars in the front of the queue allow more spacing than the
cars at the end of the line. This is for the automated car.

Definition: If
Total-numb--l
then Initial-Cal
Else Initial-Cal +Steady-sta2’(Total-numb-l)

Inputs: ( Initial-cat Initial Car delay- automated
( Steady-St... Steady State Spacing- Automated
u Total-numb Total Number of cars to be eva...

outputs: Est. total time to clear intrsct’n-A V



0 Chance Est.-total Units:

Title: Est. total time
to clear intrsct’n-M

Description: This object estimates the total time it takes to clear the intersection of all
cars being evaluated. It represents the manual driver situation.

Definition: If
(Max_speed*2)/(2*Accelerati)>=Calc.-the-
T h e n  Calc.~the~2+((2*(Calc.~the~/Accelerati))A0.5)
Else
Calc._the_2+(Max_speed/(2*Accelerati))+(Calc.-the-/Max-speed)

I n p u t s : ( Accelerati Acceleration
( Calc.Jhe- Calc. the total distance requir’d
( Calc,the... Calc.  the total time due to spat’..  .
( Max-speed Max Speed

outputs: Compare manual and Automated



0 Chance Est.-total2 Units:

Ti tie: Est. total time
to clear intrsct’n-A

Description: This object estimates the total time it takes to clear the intersection of all
cars being evaluated. It represents the automated car case.

vrr
Definition: I f

(Max-speedA2)/(2’Accelerati)>=Calc.-the-
Then Calc.~the~l+((2*(Calc.~theJAccelerati))”0.5)
Else
CalcJhe-1 +(Max_speed/(2”Accelerati))+(Calc._the_/Max-speed)

Inputs : c) Accelerati Acceleration
( Calc.Jhe- Calc. the total distance requir’d
( Calc.Jhe... Cab. the total time due to spat’.  . .
( Max-speed Max Speed

Outputs: Compare manual and Automated



0 Chance Compare-ma

Tit I e : Compare manual
and Automated

Units:

Desc ription: This compares the times for the manual driver and the automted car case.

Def‘inition: Est._total[Steady_stal=21
Est. total2rSteadv  sta2=0.51

Inputs:  ( Est.-total Est. total time to clear intrsct’...
( Est.-total2 Est. total time to clear intrsct’...
( Steady-St... Steady State Spacing- Manual
( Steady-St... Steady State Spacing- Automated



( C h a n c e Est.-how-m

Title: Est. how many cars
thru green It-M

Units:

Description: This object attempts to estimate the number of cars that get through the
intersection for the green light times evaluated. This is the manual
driver situation. This is not working corectly  yet.

w-r
Definition: If

(Est.-total  <= Time-of-g)
then Total-numb
Else 0

Inputs:  ( Est.-total Est. total time to clear intrsct’...
( Time-of- . . . Time of Green Light
D Total-numb Total Number of cars to be eva...



( C h a n c e Est.-how-m2

Tit I e : Est. how many cars
thru green It-A

Units:

Description: This object attempts to estimate the number of cars that get through the
intersection for the green light times evaluated. This is the automated car
case. This is not working corectly  yet.

Definition: I f
Est.-total2[Steady-sta2=0.5]  c= T i m e - o f - g
then Total-numb
Else 0

Inputs:  ( Est.-total2 Est. total time to clear intrsct’...
( Steady-St... Steady State Spacing- Automat&
( Time-of- . . . Time of Green Light
D Total-numb Total Number of cars to be eva...



0 Chance Enable-hig

Title: Enable Higher
Density Veh. Flow

Units:

Description: Refer to the final report regarding any information in this IVHS benefit
analysis category.

rwr
Definition: 0

outputs: Benefit-  Increasing intersct’n flow v



0 Chance Interleave

Title: Interleave
Intersection
Traffic

Units:

Description: Refer to the final report regarding any information in this IVHS benefit
analysis category.

WV-~
Definition: 0

Benefit- Increasing intersct’n flow 7



0 Chance Estimate-r Units:

Tit I e : Estimate Reducing
Freq of Accidents

Description: Refer to the final report regarding any information in this IVHS benefit
analysis category.

w-r
Definition: 0

Outputs:( Benefit- Allevtg Accident, Incident V 1
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0 Chance Estimate-r2

Title: Estimate Reroute,
Detour

Units:

Description: Refer to the final report regarding any information in this IVHS benefit
analysis category.

wrr
Definition: 0

outputs: Benefit- Allevtg Accident, Incident v
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( O b j e c t i v e  B e n e f i t  r-

Title: Benefit-
Reduce Freq
of Accidents

Units:

Description: Evaluate the benefit of improving arterial safety by reducing the
frequency of accidents.

#r
Definition:

Incr. veh- -
Important-

Inputs: ( Important- Important: Read this box
( Incr.-veh- Incr. Veh react’n  time, Manvr . . .
( Smart-stre Smart Street Control of Veh



( O b j e c t i v e  Benefit-r1

Title: Benefit-
Reduce Severity

Units:

Description: Evaluate the benefit of improving arterial safety by reducing the severity
of accidents. Refer to the final report regarding any information in this
IVHS benefits analysis category.

fV’I
Definition: 0



( O b j e c t i v e  B e n e f i t - m l

Title: Benefit-
Mitigate Accidents’
Effects

Units:

Description: Evaluate the benefit of improving arterial safety by mitigating the effects
of accidents.

w-r
Definition: Speed-care

Inputs: ( Speed-care Speed Care for the Inju...



0 Chance Smart-stre Units:

Title: Smart Street
Control of Veh

Description: Refer to the final report regarding any information in this IVHS benefit
analysis category.

w-r
Definition: 0

outputs: Benefit- Reduce Freq of Accidents



0 Chance Incr.-veh- Units:

Title: Incr. Veh react’n
time, Manvr Respns

Description: Refer to the final report regarding any information in this IVHS benefits
analysis category.

rwr
Definition: 0

outputs: Benefit- Reduce Freq of Accidents
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0 Chance Improve-si

Title: Improve Situation
Assessment

Units:

Description: Refer to the final report regarding any information in this IVHS benefits
analysis category.

w-r
Definition: 0

outputs: Important: Read this box V
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( O b j e c t i v e  B e n e f i t - d

Title: Benefit-
Decreasing
Accel, Decel

Units:

Description : Estimate the benefit of reducing harmful emissions through decreasing
the accelerations and decelerations of automobiles.

far
Definition: Reduce con-

Smart strel-

t n p u t s : ( Reduce-con Reduce Congestion
( Smart-strel Smart Street Control V...



0 Chance Reduce_con

Title: Reduce
Congestion

Units:

Description: Refer to the final report regarding any information in this IVHS benefit
analysis category.

WV-v
Definition: 0

Outputs:l Benef i t -  Decreasing Accel ,  Decel V 1



0 Chance Smart-We1

Title: Smart Street
Control Veh Speed

Units:

Description: Refer to the final report regarding any information in this IVHS benefit
analysis category.

v-r
Definition: 0

outputs: Benefit- Decreasing Accel, Decel



( O b j e c t i v e

Title:

Description:

B e n e f i t - r 2

Benefit-
Reducing
Veh milesTraveled

Units:

Estimate the benefit of reducing harmful emissions through reducing the
vehicle miles traveled.

Definition: Encourage-l
Route quid

I n p u t s : ( Encourage-l Encourage Mode Shift
( Routeguid  Route Guidance



0 Chance Routeguid

Title: Route
Guidance

Units:

Description: Refer to the final report regarding any information in this IVHS benefit
analysis category.

eQvv
Definition: 0

Outputs:1 Benefit- Reducing Veh milesTraveled W 1
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( O b j e c t i v e  B e n e f i t - m

Title: Benefit-
Managing Veh Density

Units:

Description: Documents the benefit of managing vehicular density in downtown areas.

Definition: Smooth-den
Evaluate-

Inputs : ( Encourage- Encourage Mode Shift
( Evaluate- Evaluate Access metering
( Route-gui Route Guidance
0 Selective- Selective Road Pricing
( Smooth-den Smooth density peaks thru re...



0 Chance Smooth-den Units:

Title: Smooth density peaks
thru rerouting

Description: Refer to the final report regarding any information on this IVHS benefit
category.

w-r
Definition: 0

outputs: Benefit- Managing Veh Density ‘clr
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0 Chance Selective-

Title: Selective
Road Pricing

Units:

Description: Refer to the final report regarding any information on this IVHS benefit
category.

rw-
Definition: 0

outputs: Benefit- Managing Veh Density



0 Chance Encourage-

Title: Encourage
Mode Shift

Units:

Description: Refer to the final report regarding any information on this IVHS benefit
category.

pxprr
Definition: 0

Benefit- Managing Veh Density
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0 Chance Evaluate-f Units:

Title: Evaluate
Faster Queue Clearing

Description: A specific analysis of faster queue clearing in the downtown areas has not
been accomplished. However, an analysis to estimate the effects of AVCS
technologies on clearing of intersections on major arterials is contained
in the urban arterials DEMOS model. Those results indicate a significant
improvement could be achieved.

pwr
Definition: 0

Outputs:l Benefit- Increasing intersct’n f low V 1



0 Chance Enable-hig

Title: Enable Higher
Density Veh. Flow

Units:

Description: Refer to the final report regarding any information on this IVHS benefit
category.

eovv
Definition: 0

outputs: Benefit- Increasing intersct’n flow



0 Chance Interleave

Title: Interleave
Intersection
Traffic

Units:

Description: Refer to the final report regarding any information on this IVHS benefit
category.

w-r
Definition: 0

outputs: Benefit- Increasing intersct’n flow



( O b j e c t i v e  B e n e f i t - a

Title: Benefit-
Allevtg Accident,
Incident

Units:

Description: Documents the benefit of alleviating accidents and incidents in the
downtown areas.

Definition:1 Estimate rl
Estimate-r1
Estimate r2

I n p u t s :  ( E s t i m a t e - r  EstimateReducing  FreqofAcc..
( Estimate-r1 Estimate Rapid Reponse,Clean..  .
( Estimate-r2 Estimate Reroute, Detour



0 Chance Estimate-r Units:

Ti t I e : Estimate Reducing
Freq of Accidents

Description: Refer to the final report regarding any information on this IVHS benefit
category.

pw-
Definition: 0

outputs: Benefit- Allevtg Accident, Incident



( C h a n c e Estimate-r1

Tit I e : Estimate Rapid
Reponse,Clean-up

Units:

Description: Refer to the final report regarding any information on this IVHS benefit
category.

Wr’I
Definition: 0

outputs: Benefit- Allevtg Accident, Incident

?
T;cd
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( O b j e c t i v e  B e n e f i t - r

T i t l e :  Benefit-
Reduce Freq
of Accidents

Units :

Description: Assess the benefit of reducing the frequency of accidents.

Definition: Exert dire
Important-

Inputs: ( Exert-dire Exert Direct Veh Control by SS
( Important- Important: Read this box



0 Chance Exert-dire Units:

Title: Exert Direct
Veh Control by SS

Description: Refer to the final report regarding any information on this IVHS benefit
category.

pvr
Definition: 0

outputs: Benefit- Reduce Freq of Accidents v
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( O b j e c t i v e  B e n e f i t - m l

Title: Benefit-
Mitigate Accidents’
Effects

Units:

Description: Assess the benefit of mitigating the effects of accidents.

fJvV
Definition: Speed-care

Inputs:  ( Speed-care Speed Care for the Inju...



0 Chance Speed-care

Title: SpeedCare
for the Injured

Units:

Description: Refer to the final report regarding any information on this IVHS benefit
category.

rwr
Definition: 0

outputs: Benefit- Mitigate Accidents’ Effects v
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( O b j e c t i v e  B e n e f i t - d

Title: Benefit-
Decreasing
Accel, Decel

Units:

Description: Assess the benefit of decreasing accelerations and decelerations.

ew-r
Definition: Reduce-con

I n puts : ( Reduce-con Reduce Congestion



0 Chance Reduce_con

Title: Reduce
Congestion

Units:

Description: Refer to the final report regarding any information on this IVHS benefit
category.

pw-r
Definition: 0

outputs: Benefit-  Decreasing Accel,  Decel V



( O b j e c t i v e

T i t l e :

Description:

Uni ts :B e n e f i t - r 2

Benefit-
Reducing
Veh milesTraveled

Estimate the benefit of reducing vehicle miles traveled.

#r
Definition: Encourage-l

Route guid

I n p u t s : ( Encourage-l Encourage Mode Shift
( Route_guid  Route Guidance
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( C h a n c e Encourage-l

Tit I e : Encourage
Mode Shift

Units:

Description: Refer to the final report regarding any information on this IVHS benefit
category.

pxpr-
Definition: 0

outputs: Benefit- Reducing Veh milesTraveled
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Demos
Tutorial
An Introduction to Demos

Macintosh Demos version 2.0b2
June, 1992

Not for citation or attribution

ILJllmha’
Decision Systems, Inc

.

c-191



Copyright notice
Information in this document is subject to change without notice and does not
represent a commitment on the part of Lumina Decision Systems, Inc. The
softwamprogramdesuiiinthIsdocument is provided under a Iicense
agreement The software may be us~I or copied only in accordance with the
termsofthe agmement. It is against the Iaw to copy the softvvam on any
medium except as specificaIIy allowed in the Iicense agreement. No part of this
document may be reproduced or transmitted in any form or by any means,
ekctmnic  or mechanical, inchrding  photocopying, recording, or information
storage and retrieval systems, for any purpose other than the Ii-s
personal use, without the express written consent of Lumina Decision Systems,
Inc. .
This document and the software program it descrii, Demos, am copyrighted
with all rights reserved. This program was written using IvIacAp~: (8 1985-
1990 Apple Computer, Inc.

This document is:
0 1992 Lumina Decision Systems, Inc. AII rights resewed.

TheDemossoftwareprogramis:
0 1982-1991 Carnegie Mellon University,
0 1992 Lumina Decision Systems, Inc AII rights resewed.

The Demos software is lid from Carnegie Mellon University exchisively
to Lumina Decision Systems, IIW, and includes software proprietary to Lumina
Decision Systems, Inc.

Camegie Mellon University and Lumina Decision Systems, Inc., make no
warranties whatsoever, either express or implied, warding this product
including warranties with respect to its merchantability or its fitness for any
P”ticuL=Purpose.

The Ma+p software is proprietary to Apple Computer, Inc., and is Iicetwxi
to Lumina Decision Systems, Inc. only for use in combination with the Demos
Progam

-
Apple Computer, Inc., makes no warranties whatsoever, either express or
implied, regarding this product, including wanimties  with xespect to its
merchantabiity  or its fitness for any particuhu  purpose.

LumIna Dcdsion Systems, Inc.
125 California Avenue, Suite 200
Palo Alto, CA 94306
Phone: (415) 3274944
FAX (415) 3261769
AppleLirk  Lumina
Internet:  Lumina@AppleLin.kAppIeCom
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Getting started
Welcome to the Demos Tutorial. This is a handsan  introduction to using
Demos. Inthistutorial,youwilllearnhowtoinstallDemosonyourharddislc
how~oloreansdstingDemos~~,urdhowto~teanew~
pmjtrt  using step-bydep  instructions.  Ihe tutorial  is divided into three partr,
and you can cover the entire tutorial in under an hour.

a

cl

0

Cettlngrtarted about 5 minutes

ThispartshowsyoushowtoinstallDemosonyour~aereoyoucan
getstarted.

Exploring a Demos project about 15 minutes

This part shows you how to start up an existing Demos project, how to
examine the model structure and assumptions, and how to generate tables
and graphs showing the remIts of the model. It also shows you how to
generate  pmbability  distriiutions  that characterke uncertainty, and how
to do sensitivity analysis to see which uncertainties are most important.
The example mcxiel analyzes total costs of buying and-owning a house.

Creating a new Demos project about 25 minutes.

This part shows you how to create a new Demos project from scratch. It
shows you how to create variables, define dependencies, add
documentary text, and compute results. ‘Ihe example model analyzes the
costsofowningandrunningacar.

This tutorial is designed to familiarize you with the user interface of Demos,
and introduce you to some of its basic features. Once you have become
familiar with the interface and featxuzs of Demos, you should refer to the
Quick Reference for more information about the windows and menus in
Demos. The forthcoming Demos Us&r Manual will provide more details
about the functionality of Demos to build more complete models.
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What you are expected to know
You need to have the basic skills in using a Macintosh computer. These
include knowing how to point and cIick, double-click, and drag the mouse.
You also ned to know how to use pulldown and popup  menus, scroll bars,
and the basic!3 of using windows.

If you are unfamiliar the basic skills descrii above, we recomnxnd that you
use the Macintosh Tour or Macintosh Basics disk that comes with your
Macintosh to learn these techniques, step by step, on your computer. Check
your Madntosh Getting Started booklet and Macintosh User’s Manual for
details.

Demos versions
All versions of Demos require a Macintosh with enough RAM memory (1.5
megabytes). There are three versions of &mos available:

DemosPPU

DemosU

Demos demo

This is the full version of Demos with all capabibties. It
requires that your Macintosh have a Floating Point Unit
@PLO. It will run on any Macintosh except the Mac Plus,
Mac Classic, Mac SE, and Mac LC, PowerBook 100, Mac IIsi
without optional Pleating Point Unit, or any other Macintosh
that does not have a Floating Point Unit.

This is the full version of Demos, but does not use a Pleating
Point Unit. It runs about 30% slower than Denux PPU on a
machine that has a Floating Point Unit.

This demonstration version is available for free, and can be
copied and shared freely with other people. It does not
require an PPU. It lets you do anything the full version of
Demoscando,exqtitwillnotsaveanychangestoa
Iluxkl.

YoumusethistutorialwithanyoftheDemosversions. Ifyouusethe
demonstration version, you can wen go through part 3, to learnhow to create
a new model. But you won’t be able to save the new model you have seated,
andsowilIloseitwhenyouquitDemos.

2
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Installing Demos
. ThefirstthingtodoistocoWtheDemosprogramontoyourharddrive,ifit

isn’t then? already. You will need a floppy disk containing Demos and the
sample models. The same installation procedure will work with whichever
v-ion of Demos you have - Demos FPU, Demos U or Demos demo. The only
diffewue is that the Demos folder and application may have different names
from those depicted, e.g., “Dxnos demo” instead of 7Demos”. Follow the
instructions in the boxes.

1 Tumonyourblacintosh.

Youwillnowseethe
Demos disk icon on the
right side of your SMZII.

Check if your Macintosh is 6 File Edlt Ulew L a b e l  Speclal
running System 7. If it is,

Del

therewillbeaballaonheIp
?neartherightendofthe
xenu bar.

If y-our Macintosh is not
running system 7, skip to
steps. lfitisrunning
System 7, continue to step
4.

/ Pert1 Getting startrd
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For System 7 users:

4 Dragtheiwnofthe
diskette onto your hard
disk.

You are mw done-Demos
is installed onto your hard
disk. Tumtothencxt
page.

For non-System 7 users:

5 select New Folder from
the File menu to cnzate a
folder on your hard disk
Label the folder ‘Demos”. 1 \

Brian8

.

4 Getting Started
C-198



Balloon Help
Balloon Help provides text to explain each imn, button, field, menu item or
other features of the user interface of a Macintosh program. When you move
the mouse cursor over the feature, the explanation text appears in a cartoon-
like tabon pointing to the featu~. Balloon Help is available on Madntoshes
thatarenmningSystem7.  YoucantellwhetheryourMacisnmningSystem7
byw~therPisa?neartherightendofthemenubar.

l File Ldlt Mew Lobe1 Spec ia l cm3J

Ress on this ? menu to &e the Help Menu. Select Show Balloons if you want
to switch on Balloon Help.

Show Balloons I

We recommend that you use Balloon Help when you first start using Demos.
whenyoubecomemorefamiliarwithDemosyoucanhunitoffagaih  Totum
it off, press again on the 7 menu, and select Hide Balloons;

Getting Started
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1 Doubleclick on the Demos
folder, to open it up.

I 2 Doubleclick  on the Models
folder, to open it up.

Exploring a Demos project
You tan explore an existing model by sbrting  the model in the conventional
Macintosh way as described below. In this Section, you will browse the House
model,aDemospropctthatcomparesthe~tofrentingtothecostofbuying
ahouse. By emmining  this project, you should become familiar with how to
ctxamhe and evaluate a model.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Eh. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . rl. . .

AsDemosstartsup,you  ,
will stx this initialization
w i n d o w .

The progress bar shows
l?owfarDemosisin
initializing.

Then#asitstartsupthe
model,youwillseethis
~%$&y$ows. .
reading in the model.

ltiii8 P A-F!L fJ. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
-- I decision modeling system

Vonlon  2.0b 1 FPU of June 23,1992

01982-91  Carnqle Wlon  Untver8tty
01992 Lumln Dmctrion  Sptem~, Inc.

Early Adopter Bob Rlaae - for Manaa  USI only.
Demw mry not be capiod,  aold,  lent or otlwvtr  prwtded
to anyone  rho.  Contact Lumtn Doctrlon  Syrtwna for more
tnformtion,  or to obtain a Cmonrtntton  copy. -

Brian Arnold
Lumlna Decision Systems, Inc.



Recognizing objects on the diagram
Whenamodelisstartedup,Demosdisplaysthetoplevelofthemodelinan
influence diagram window as shown below. A model contains a number of
objects of different classes. Objj classes include decision variables, chance
variables and submodels. The shape of each node i nthe diagram indicates its
object class.

Tkbrowsericonisgrayed-
out,indicating that you are
inbrowsemode. This
meanSyOUCanBcaminetht?
diagrambutnotchangeit

Dedsion variables are

~E~,~
variables that amdirectly
under the control of the
decision maker.

Chanm variables are
rep~tedbynodeswith
round~corners. In
general, chance variables
- TheyGannot

Zcontmllfzd  dinxtly by
the decision maker.

Submodels are represented
by thick-lid nodes with
rounded ColW3s.A
submodel contains its own
influenclediagram,
showing mre detail.

The objective variable is
repmated by a hexagonal
node. The objective is the
variable that evaluates the
overall value or desirability
of outaIme% In this one,
thfqpalistominimizethe
Annualirai housing cost.
Most models contain a
singleobpctivenode.

c-202
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i

Thisisthexlu?as-t
unik  for the quantity. The
units here is dollars.

The object’s class is
Decision  variable.

Thenameofthisobjjis
Downpaymt. It is used to
refer to this variable in def-
initions of other variables.

Thetitleofanobjectsays
briefly (up to 36 characters)
what it is. The title is also
shown in the node.

The description provides
more amplete documen-
tation about this variable.

The definition is a simple
number. 12OK means 120
thousand. The definition
may aIs be a pmbabiity
distribution, or other
mathematical expression.

outputs  are variables that
depend on this variable.

Opening an object window
. Every object has & objj window which shows detailed information about it.
You can display the objj window of an ob@t simply by doubledicking  ik
nude in the influence diagram. Information about an object is structu& as a
I&t of attributes. The attrlltes  of a variable include ik class, name, title, units,
description, definition, and outputs.

Udiz t

Pet2 Exp&ringaDmosprojest
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Moving to other object windows
An alternative to displaying an object window by double-clicking ik node on
the influence diagram is to explore the inputs or outputs of a displayed object
window. The objj window for a variable contains a list of ik inputs, and a
popup menu of ik outpuk. You can replaa? the variable in the object with one
of ik inputs or with one of ik outputs.

1 F’ressheretoshowapopup
menu of the outputs of this
variable.

2 Holding the muse down,
slide the cu.mor to highlight
Load, and release it, to
select that variable.

Laan is a Chance variable.

The definition of the L.oan
amount is the difference
betweenthePriceandthe
Downpayment  The
definition refers to these
vaxiables by their narms.

The list of inputs shows the
namesandtitlesofthevari-
ables in the definition.
Whenthenamesambrief,
the titles help explain what
they tder to. Down pay-
ment, the variable we cam
from, is one of ik inputs.

Davn prymrnt on how0 rt purchmo.

vv

II

-IltB
-BB

Titlr: lmn
I

-I4 Dawlptlo~: Tote1 mortgage (lad omount. I

m-’Daflaitlr . Prtca - DovnPoymt

YOU a de w&m 1
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

1 kffdti@B: Prltr - bVnhUlld
[..,

window for any input bj.
doubldcking on it.

3 Double-&koninputPrice.

Dovnpymt Down pogmnt

The objj window now
displays the attributes of
Rice.

4 ClickontheDiagmmicon
toretumtotheinfluence
diagmm

10 Erploring a Demor  pjazt
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The diagram kindow is
frontmost  again. Note that
the variable Buying price is
highlighbxl  (in reverse
video) to show we were
iust examin@ it. Of it isn’t
highlighted for any reason,
highlight it by clicking on it
once).

. 1 Clickontheexpandiconin
order to open the attribute
view.

Using the attribute view
As an alternative to viewing attri’butes of a variable in its obpct window, you
can inspect attributes in the attriite view. This is an auxilkuy window pane
that you can open below a diagram window. The attribute  view lets you
rapidly examineoneathibuteatatimeofanyobjectinthediagraxn Youcan
~~whichobjecttoviewby~~itinthediagram,andyouoanbel~
which attribute you want from a popup  menu of attributes.

Youcannowseethe
description of Buying price
in the attribute view. \

\

12 presSheFetoshowtk.pop(\
upmenuofallthe
attri%utes of the t&cted
node.

Part2 Eqloring a Demos projazt
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1 Press on the attrit&
POPUP -ug drag to
Definition and release to
seltiitasthenewcurrent
attribute to display.

You will he the definition
of Buying price here. It is a
single number, 4OOK,  that is
4OWlO.

2 ClickontheDown
yment variable to selxt

.

Inspecting definitions in the attribute
view
The attribute view allows you to view any attribute of an object For example,
you may want to look at the description of each variate, or the definition (as
we show here).

You will see the definition
of Down Payment here. It
is also a number, 12OK, that
is 12opoo.

You will see the definition
OfLcHnhexe. Itisan
expmsion, using the
nsmes of Down payment
subtracted frombuying
price. In this way, you can
look at the definition of any
variable in the model.

. . . . . . . . . . . . . ..*........... . . . . . . . . . . . . . . . . . . . . . . . . . . . .q ‘m”B *&irv . . . . . . . . . . (I.<

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

* pzti ~~~~~~.~

iJ/(I

\
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Inspecting values in the attribute view
The attriiute view allows you to view siome attributes, like the Value, which
are not (initially) shown in the object window. When you ask to show the
Value attribute of a variable, Demos will first compute it automatically if
=-w

1 Press on the attribute
ptyf -u and select

.

Probusluo
outputs

You will we the value of
hhere(actuallythemid
or detwministic value).

280K

Demoswilltakeamoment
to compute the value.
l’hen,youwillseethemid
value of Annual&d
housing cost. ln this way,
youcanlookatthemid
value of any variable in the
mtxiel.

Part2
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Displaying an uncertain value

The definition is a Normal
distribution, with a mean
value of 10596, and a
standard deviation of 15%.

You can display the value of a variable in several different ways, some
numerical and some graphical. Even if the variable is uncertain, you can
display its mid (deknninktic) value. The mid value is computed assuming all
uncertain  variables are fixed at their medians. It is much quicker to compute
thanafullprobabilisticvalue,andsoitis~forinitialchecksofthemodel.
Dams offers a wide variety of views to display the uncertainty in a variable,
including selected statistics, probabiity bands, a graph of the probability
density function or the cumulative distribution function, or even the table of
random numbers from which the distribution is estimated. Hm you will us
several of these views for a variable defined as a normal probability
distribution.

3 ‘his icon represents mid
t-c) value It is
the current  option for
displaying the value of the
sekted variable. click on
it to display the mid value.

This window appears with
the mid value shown The
mid value of a normal
distribution is its median
whichisthesameasits
mean, 0.105, or 105%.

C-208
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4 Pressontheuncertainty
view selector popup  Hwu.l
toviewthetanmtahty
view options, drag the
lJyluse to statistic5, and
release. ’

Shown are the minimum,
median,mtan,maximum
and standard deviation.
Theyarenotex2ict,since
they are estimated from a
sample of values from the
distribution. Using Latin
HypercubesamplingAhe
medianandmeanan?very
closetothetruevalue
0.105. For a normal disti-
bution, the true minimum
andmaximumisminus
and plus infinity. Demos
truncates the distribution at
minus and plus 3 standard
deviations from the mean.

5 usethe-ty view
selector popup  menu to
change& current option
to Probability Density.

The height of the cuwe  at a
given value along the
horizontal axis denotes the
relative probability that the
variable has that value. The
unikoftheverticalbcale
alechcsensothatt.hetotal
Ut?aund~thecurVeiSl.

A Note: the window changes
from showing a table to a
graph, because the proba-
bility density cannot be
shown numerically
(currently).

Port2
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This the cumula~ve I
probability of the sp&fied I
Normal distributions This
cum2 gives the probability-
ontheverticalaxis4hatthe
Intelvstrateisl~thanany
given value along the
horizontal axis.

7 usethe-ty view
sektor popup menu to
change the view to Sample. \ .

r
This table lists the 100
sample values which F
Demos genera&i at fi
random from t.k true
distribution to estimate the
statistics and probability
distributions. If you need
molt precise estimates, you
can increase the sample
sizeketheQuick
Refenznceonhowtodo
this), but a sample size of
100 is fine for this tutorial.

16 Eqdoting  a Demos pwjcct
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Displaying uncertain results
‘The Interest rate you just examhed was an input variable to the model. You
CM use similar methods to look at the probability distribution for an output of
themodel-inthiscase,theAnnualizedhousingoost  Youcandisplaythevalue
of a vahable e&her from the Diagram view, as we just did, or from ik object
window,aswewilldohenz.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

The definition is an

unc&ain,andsoikvahe
will be probabilistic.

This window appears with
the mid value shown.

3 usetithety view
selector popup menu to
Change the cxumnt option
to Mean Value.

lhmoswilltakeafew
moments  to compute the
mea.vinc?etbis~uires
probabilistic evaluation of
tkentiremodel.

-I

\* I p

b
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ...‘...
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Note that the mean value of
17.O!JK  is different from the
mid value of 142K.  This is
btXiW%?the~iSeSti-
mated from the entire
distribution.

The probability density is
displayed fairly quickly.
Demos alwdy computed
the probabilistic value of
the variable to estimate the
mean. Since it keeps inter-
mediate results, it does not
ncxdtorecomputfzitto
generate the probability
density. The graph appears
%ois~  because we are
using a sample size of 100.
Using a larger sample size
would produa a smoother
curve, but it would take
longer to compute.

Thecumulatiwprobability
distribution looks a lot
~m00ther than thedensity
functionbecauseitisthe
integral of the density.



This shows the influence
diaplm of the Annual
costs submodel. This
model computes the net
annual housing lmst#
including the principal and
interest payments on the
mortgage, the reduction in
-, pq=q -,
insurancl?,maintenance,
andculTentrent.

This input anow head
shows that this node has
one or more inputs from
outside this model.

This output arrow head
shows that this node has
one or more outputs
outside this model.

Opening a submodel
Demos models gemendly contain 8ubmodels  Each submodel contains the
detailsofapartofthemodel,Plso~tedasanMuenoediagram.  Inthe
house ewmple, the capital costs bsts assodated with buying and selling the
house) and the annual costs bsts associated withowningand maintaining the
house)areeachintheirownsubmodel.  submodelscanalsoamtain
submodeb. Inthisway,alargemodelwithhundFedsofvariabllescanbe
organhed into a l-Gem&y  of models, each small enough to be aqx&ensl%le.

f
Annual

1uxmcWn .

I . . . . . . . I . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ..A.!.........................J . . . . . . . . . . . ..s

.
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13 To open the submodel, I*- ( Diagram l House cost analysis m?q

The diagram window for
Capital costs appeaft and
r+aa?s the Annual axk
diagram. Demosamemes
the number of windows at
each level of the model
hiertiy to minimize
clutter on your desktop.
SeetheQuickRf&encefor
tips on how to open more
than one submodel
diagram window at a time.

I 5 ClickontheLoannodeto
select it.

6 Select outputs from the
attribute popup to view a
list of the outputs  to ban.

7 Doubhlick on Annual

Thehnticoskmodd
diagram is brought
fmntmost,andthehnual
paymentsnodeisdected.

Diaaram l Annual costs

8 ClickontheDiagramiam,
ton?tumtotheparent
diagram, House cost
analysis.

Part220 Exploring  a Denwrprojbct
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Importance analysis
Inthishouse~~lilremostDemos~els,manyoftheinputvariables~
tmcerbh.  It is interesting to know how much each of then uncertain inputs
contriites  to the u”certainty  in the output. Typically, a few unc&ain inputs
are responsible for the lion’s share of the uncertainty in the output, and the rest
have littIe impact 7his  -llncertainty  analysis” or “impoltance  analysis” tells
you that if you want ti 8x33x-e the ovaall uncatainty, it will be most efftxtive
to concentrate on getting ktter estimates or building a more detailed model for
those one or two “important inputs, ud you can ignore the rest. Thus,
importance analysis can help you Mine your model much more efficiently. It
can also ease your WOITies about those -ties which tum out not to
matter very much-typically, most of them Demos defines “importance” as the
rank order co&&ion between the sample of output vaIues and the sample for
each unchain input. It is a robust measure of the uncertain contribution
becauseitis insensitive to extreme values and skewed distriitions. Unlike
commonly  used deterministic measures of sensitivity, it averages over the
entire joint probability distribution. So it works well even for models where the
sensitivity to one input depends strongly on the value of another.

Importance is on a relative
scale from 0 to 1. 0 implies
noeffectofthekmceain
input 1 implies total
cod&ion, so that ail of the
unm%+.inty  is due to this
input.

1tisclearherethatthe
input Appreciation is
contributing the lion’s share
OftheUncPrtaintyinthe
Annualized housingmt.

Part2 Erploring  a Demos project
c-215



Parametric analysis
Parametric analysis means varying the value of an input variable to examine its
e&ct on a sekted output. It often gives useful insights into what’s important,
and how a model behaves. Because the importance analysis revealed that the
Appreciation contributes much of the uncertainty in Annualized housing cost,
we will start the pammetk  analysis with that input variable. We will change
its definition from a probabiity distribution to a list of alternative values.
Demos will then graph the axresponding values of the output.

WewiUnowsp&fy
Annual appreciation as a
list of altelnative values,
from 0 to 20% (0.2).

3 Presson theexpmsion .
we POPUP -un drag the
mousetoLis~andrelase.

Lvan Annual
R 2

Oemos auest’on 
Replace current deflnltlon with a List?

A Notqmsingthe-
keywilldothesamz

[NO) bVesJ

I
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Anewcellwillappear
wlm3lyoupressthe~
keyinthelastcl?ll.

6 Repeat the previous step
threemoretimes,entering
0.05 (511,O.l (lO%), and
0.15 (15%).

Inthelastcell, type02
(20%) but this time, pNSs
the enter key so it won’t
add an additional cell.

.

.

7 Select A~ualize.d  housing
costandclickontheMid
value unc&ainty view
option to show the
recomputed value.

The mid value is no longer
asinglenumber! Thereisa
computed value for each
parameter&d value of
Annual appreciation.

8 Usetheuncerhhty view
selector popup menu to
view Probability bands.

\

/

1

Part2

Diagram l House cost analysis m

Z!SEZ Mid Ualue l lnnualized housing cost (t/year) m
x Axlr: Amavrl rpprecirtirm  (/gear) V
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Theblx%ik~pointisthe
Annual appnxiation  value
ctnm?sponding  to where the
probability band of 95%
yield!3 an ANudh?d
housing cost of above 0
<S/year), which is at about
8%.

9 Clickontktableiconto
viewPro&biWybandsasa
table of numknm.

Hexearetknumerical
values for the probability
bands of housing a6t.

Clickonthediagramicon
toretumtotheHouse
diagram  window.

24

Probability Bonds l Annualized housing cost (S/year)
rl

IO 10.05 lo.1 lo.15 lo.2 I
-24.a -7320 1?.2aK 65.2% 100.9:

-2IU -27z3 22.51( 62.lK 121K
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Evaluating alternative decisions

1 ClickontheBuyingpke  ,
node to select it.

2 ChangeitsDefMtiontoa
List of values. Answer Vet
to the dialog that asks if
you’re sure you want to do
this.

3 selectthefirstcellby
clicking in it. Type the first
number 2OOKand press the
return key. Type 300K into
thesecondcellandpress
thereturnkey. Type4OOK
inthelastcekndpressthe
Enter key.

\

Youwilllearnhowtochangebuyingpricetoviewanda>m~resultsbased
on alternative decisions. In doing so, you will learn how to perform parametric
analysis on two variables, Buying priceand Annual appreciation, at the same
time.

\

c6sls

Annualked

u

\ WQT

holmg co&

Loan Annual
-

4OOK p

4 Select Annualized housing
costandclickontheMid
value uncertainty view
selector button to
recompute and display its
value.

Port2
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5 Choose probability bands
fromthewuxtainty view
selector popup menu.

Notice that them are now
thnx dimensions to the
result, Probability, Buying
priceand  Annual
appreciation.

Because only two
dimensions cil~l be shown
in the graph one slice of
the third dimension is
chosenhere.

T

1

.

.

[

J

h

I
i

.

.

!
.

==3 Mid Ualue l Annualized housing cost (S/year)  
KOm:

m Probablllty Bands l Annualized housing cost ($/year)  B
Bmdmq  prlu (SK) b 12001:)

Kg:
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6 Ressonthistopopupa
scrolling list of other values
in this dimension.

7 Select400Kbyclickingonit
OIMX!.

Thegraphchangestoshow
the two dimensions given
thethirdindexequalto
4aK

8 Clickont.heDiagramicon
toretumtotheinfluence
diagmm.

W Probability Bends l Annualized housing cost (S/yew)  B
br#lDg )rltD (SK) b [7iiiq

KD& Prokbilltg v
x AXID: Amul rp)ralrtirr  (IO#r)

----dL#(y-tUYW
lsu
lrn
SSK

0
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I 1 Select guit from the File
menu.

Because you have made
change3tothemodel,
bnoswillaskifyouwant
tosavethosechanges
befork? quitting.

2 Click on NO to indicate that
youwouldliketoquit
without saving. l-

A NokTheDemos
application is now closed.
To open it again nzfer to the
beghingofthissection.
To learn how to create  your
own modeI, continue with
thetlmrid.

Quitting a model without saving
WhtXtyOUhaVefiniShed examin& a model, you may want to quit. It is best b
quit without saving changes, unless you meant to edit and save. Here, you will
find out how to quit without saving. Later, in the section on aeating  a new
pmject,  you will learn how to save your changes.

Open Prijecl...

New TeHt
Open,.

IIN
SO

Close
Close ProJect
Soue #S
Sotie As...
Soue a Copy In...

lmpor t...
LHpoll . . .

Page Setup...
Print...
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,Creating a new Demos project
You cm start up Demos in the conventional Macintosh way by doublexlicking
onthebncisicon.  Youcanthenopenanexistingprojectorawteanewone,
asdesaibedhexe.

The Demos start-up
graphic will then appear,
withabarshowingits
progress at initialization.

13CXXeretoaeateanew

\I e decision modeling system
Vonlon  Z.Obl FPUofJun25,1992

trrlyhdopterkta  U8le4w-for Liarwuseonly.
Dd~~ynotbeco~~,rold,lcntorothcrv(mprovldbd
tornyonerlrc.ContactLumin DectalonSyrtamsfiw  more
tnfornwtion,ortoobtalnrdwnortstntionwpp.

Brian Arnold
Lumina Decision Systems, inc.

1 initisiizin~~ I

Select end open an enisting proJect, or click New
e new proJect.
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Documenting the Model
This object window appears after starting a new projrxt  A project consists of
one or molp models. The project itself is the main model. It will contain text
attriites, including name, title, description and author. These attributes will
identify and describe the Model.

1 Type”GuaWYnthebox
tonameyourmodel. Ifyou
begintypin&thetextwill
automatically appear in the
box. ‘Ihenamewillhold
upto2ocharaWs.  Press
the Enter key.

2 Clickheretolabelthetitle
more descriptively. Type
“Car Cost Model” Press
Enter. Demos will accept
upto36haracWsonupto
3linesoftext.

odd:  Thu, Jun 18,1992 9:09 PM

3 Clickkretoprovidea
description of the model.
Type “A demonstration
modeltoshowbwto
compute the cost of
running a car.” Press
Enter. Demos will accept
any amount of text for
thedescription. Note that

Repeattiprocedureto
add your name as author if
your computer does not
automaticallyxegisteryour

Dmctlptlom:  A bmonatntlon  model to tfuw hov to cornput  the cost of runmng

Created: fhu, Jun l&l992 9:09 PM

30 Creating a new Demor
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.

Initially,youwillseea
blank diapm window.
m.siswhereyouwill
createaninfluencediagram
showing variables and their
dependencies.

You should see the
canmand icons associated
with the edit mode. These
command  icons allow you
tocrdenodesinthe
diagramandamnectthem
with influence arrows.

Browsing or editing a diagram
.Thebrowse~eisusedtoviewansristingmodel,withoutchangingit. The
editmodeisusedinmodel~tionortochangeansdsting~el.  Besureto
note which mode is activated throughout this tutorial. When a mode is
selectd, the icon is grayed-out. When you ante a new model, its diagram is
initially in edit mode.

Part3 Chafing  P IVW Demos pm~kcf
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1 Clickheretoselecttheedit
kon. If you have continued
from the previous page, the
icon should already be
grayedout.

2 Clickhere,onthechaxa
kon, and drag the outline
of it to a position on the
MPm.

Anewchancevariablewill
appear where you release
themouseinthediagnm.
Its text will automatically
besektedforyouto
specify its title.

3 Type “Fuel Cosr to title
the variable. Press Enter or
singledickanywhereelse
withinthediagramto
indicate that you have
t5nished the title. Demos
will inkqxetRehmasa
newlineinthetitle).

Your diagmn should now
look like this.

Note that the Fuel cost
node is f&d with diagonal
linepatternamunditstext.
-Illisindicatestoyouthat
theitsdefinitionhasnot
been e~@cit.ly  defintxi  yet.

32

D
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Creating a variable
Inthistzxample,youwill beginamodelofexpenmforoperatingacarforone
year. When building a model, it is important to select descriptive titles for
your vaxiabks. You will start by creating the variable Fud Cart.

/
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1 To make another variable,
singwck on’the chance
iconagainanddragthe
outlim to a position on the
diagram.

2 Type “Fuel”. F4essRetum
to enter part of the title on
the sea& line. Type
“Price” to finish the title.
Press Enter.

3 Clickonthechanceicon
again and drag the outline
to a position on the
diagram. Title this variable
‘AnnualMi.les”. Press
Enter.

4 Cickonthechanceicon
again and drag the outline
to a position on the
diagram. Title this variable
‘Age”. Press Enter.

5 Ckkonthechanceicon
againanddragtheoutline
to a position on the
diagram. Title this variable
-Mpg”. press Enter.

Creating more variables
‘Repeatingthe8tepsfromthepiwiouspage,youwillcreatefour~
variables on the diagram. Four vaxiabk  affect fuel cost. You will also mite
and title these variables: Fud Riu (price per gallon of gasoline), Annual Miki
(number of miles driven each year), Age Mrivefs  age), and Mpg (miles per
gallon of gasoline).

Part3 Creafing  a new Demos project
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Saving your model without quitting
After you have created part or all of a model, you may want to save it. You
will learn to save your model without quitting. Saving periodically during
model creation is recommended, so you won’t lose too much if the program or

A Note: You an also type
1(S onthekeyboadasa
shortcut.

Demosinitiallyusesthe
title of your model, Car
costModel,tonamethe
file. If you want to name it
difkently, Press the delete
key to erase the default title
giventothefileandtype
something else.

12 ClickontheSaueb~l-

.

I u (NBW]-I .
1 Cancel J

L S a v e  1

34

Yourrmdelwi l lnowbe
savedinafilecalled”Car
Cost Model”.
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Deleting objects

1 SelecttheAgevakbleby
clickingonthenode. Select
Delete from the DbJect
menu (or press the delete
W).

A NokBmoscannotundo
a delete command. So, to
make sure you want to
delete the selected object, it
asks you before amtinuing.

2 Click Yes to indicate that
you would like to delete
theobject.

Sometimes, you will want to delete objects that you had once wanted to
include. In this emmple,  you realize that the driver’s age is not critical to your
understanding of fuelcost The&ore, you want to delete the Age variable.

. . . .. . .

6ziiD
. . :!n . . .. .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1ji

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

 Demos Question 
t

. . . .. . . .

q  Are you sure gou want to delete selected obJect?
E

(Csncel)
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Selecting and moving object nodes
You would like to move the variables so that the three variables contributing to
fuel cost surround the Fuel Cost variable You begin by learning to move a
variable node in the diagram. It can be more convenient to apply commands to
more than one objj node at a time. Most commands applied to one selected
node (or variable) can also be applkl to other nodes at the same time. You
willlearn~oselecttwonodesandmovebothnodestoanotherlocationonthe
dhF=

1 TomoveFud6st,press
themouseontheFudC&
nodeanddragittothe
position shown in the
second diagram on this
page.

2 InordertomovetheFud
PdcenodeandtheAnnuul
Milcsnodeatthesame
time, click on the Fuel Price
node to elect it.

A Note: Another way to
select more than one node
istodragaboxaroundthe
nodes you want to sekt.

3 Hold the shift key down
and simultaneously click
on the Annual Miles  node.
Now, both nodes are
selected.

4 Ressthemmseinsidethe
Annual  miles node and drag
thetWOlWdet3tOthe
position noted in the
diapm below.

5 aickanywhereelsewithin
thmiiagramtodesekt
tllelietwodes.

A Notcyoucanundoorredo
a drag operation using
Undo/Redo in the Edl t
menu, or by typing wz.

36
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Editing the title of an object

I1 Suppe you would like to

=l==-undi%*
nodeindicatethatitis
selected.

,Each~inthemodelis~~byanodeanthediagram  Youmay
deddethatyouwouldliicebchangetheti~of~obpato~themodel
easier to understand. For example, suppose you want to change the title of the
objecth4pgtoh4ikpl?rGuzlon

A Note: L~~~veabriefpause
betweentheclicktosdselect
thenodeandtheckkto
selectthetextinit  Ifyou
complete two singledidcs
tOOCpliCkl@tZIlOSWill
interpret it as a double
click and an objj window
Willopen. IfyOU
accidentally open the object
window, simply return to
thediagram byclickingon
ik diagram icon.

............ . . . . . . . . . . . . . ..... . . . . . . . .

.............. ............................................. ................................
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2 RessdownontheMilespa
G&m node to highlight it,
ifitisnotalready
highlight&.

Drawing arrows between nodes
One powerful element of Demos is the ability to show relationships among
variables through the creation of the influence  diagram. Arrows are used to
specifythedependenciesbetweenandamongobjects.  TheMiksperGallon
variable influences the Fud Cast variable. You will learn to draw an arrow
from one nude to another.

4 Fkl~thebutton

The nodes should now be
txmmctd

38
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1 To delete an arr(lw, repeat
the prod= for creating
anarmw. Clickonhfiks
peddon. Dragthea.mw
from Milts pa G&n to Fuel
Gkst.

The arrow should
disappear.

Todrawmorethanone
MOW at a time, you can
selectmorenodesusingthe
shift key.

2 Ressdownontheshiftkey
UrdCliCkOnFUdpriu.
Similarly, shift-click on
Annudmilts.Al.lthree
vahables shown should
nowbeselectecl.

4 Releasethebuttcm. You
should IIOW see three
arrows pointing to the Fuel
Cast node.

Deleting arrows and connecting multiple
arrows
Sometimes,itwillbe~tialtodelebeanMOwduetoachangeinyour
understanding of the model or other factors. In this example, you will delete
the armw cmnecthg Miles per Gallon with Fuel Cost. You will then connect
the three variables contributing to Fuel Cost to the Fuel Cost node with arn>ws.

Part3 Creating a nmo Demos project
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2 To open the object window
for the Annual Miles -PIvariable, doublc+cIick  on its b
node. IF

A Note: Youcanalsodouble-
clickonanodeinEdit
mode,toopenanobject
window. However, if you
doubleclick too slowly,
Demos will interpret your
request as two sin&&~
Thus,youwillbeina
position to edit the title as
shown previously. To
retumtotkstepabove,
simply click somewhere
else in the diagam space.

Tht?ObjjhS!3iSoWCe

variable.

The name is Annualmil.
Demosassignsthename
when the title is created. It
usesthefirst10characters
ofthetitlewiththe
zhnsf stipces which

underscores. Demosdoes
not differentiate between
upper and lowe!US?

The title is Annad Miles.

Boththenameand titlecan
betxmeddirectly.

Opening an object window
Each objj has its own objj window containing text attributes describing and
defining it. You can open the object window to enter or edit this information.

I 1

 Diagram l Car Cost Model m

Qa1 I~. . . . . . . . . . :,..I!.  .A.!:  ,.,.,.,.,  :,_:  : :.  . . . .O&i 1: :I I $.g !!&j
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!
1 To change the, title, dick in

thetitlef&d,uaethecursor
toseIecttextandusethe
dektekeytoeme”AnnuaI
Miles”. Type “Miles per”,
andtheretumicqt,and
-year-. Fh?ssEnter.

2 Tochangethename into
an abbreviated shorthand
formilesperyear,clickin
thenamefield,usethe
cursortoselecttextanduse
thedeletekeytoerase
“Annualgil”.  Type
%fpf Press Enter.

I I
3 aickheretospedfythe

unitsbox. Type
%iles/yea.f’ Press Enter.
Demoswilltlszthis
information when it labels
graphs or tables that
involve Mik pn Ycat. It
isnotusedaspartofa
mathematical function.

Entering object attributes through the
. object window

An important characteristic of Demos  is that documentation of the model and
icSv~blescanbeaddedasthemodelisbeingaeated.  Objectattributescan
be entered or edited through the object window.

Two: tllla pr

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

4 cliclchereandtype
yAvemge  miles driven per
yea? as the description
Press Enter.

thit8: mlldycrr

Pmf3 &eating a new Demos ptvject
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Explicitly defining a variable
Nowthatwehavedocumented the variable Miks per yartr, we wish to give it a
mathematical expression for how to compute its value. We will define Miks
per yaw as a single number.

kmosshowsawarning
icon next to the definition
to indicate that this
variable’s definition hasn’t
been explicitly defined yet.

The warning icon will
disappear.

A Note:Anytimeweuse  the
n a m e - t e d w i t h t h e
Miles per Yapr variable in
the definition of another
variable, Demos will
automatically uses its
value, 12K.

3 Single-click on the diagram
icontoMumt0t.k
&gram.

fitlr: Hila per
wr

Dwcriptior: Aveng,mil~drivenpar~r

NotethattheMkpnyan
nodeisnolongerfilled
with a diagonal line pattern
arounditstext.  Thisis
becauseM&spayaarnow
has a computable
definition.

C-236
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Defining variables that are influenced by
other variables
The “Fuel Cost- node has armws pointing to it, indicating that it is influenced
by other variables. We will leam how to specify the dependance with a
mathematical expmsion of those other variables.

1 15o~ckoqFuelCost
to open its obiect window.

The names of the input
variableswillappehinthe
defmition for “Fuel Cost”.
Butsinuztheformofthe
depmdaxe hasn’t yet been
specified, it is just
“FUCtiOnoK...)“.

2 specifytheunits,
description, and definition,

. as shown.

The definition must appear
exactly as shown. Delete
allexwneouspartssuchas
“FunctionOf”andall
ccmmas. Cut and Paste
commandsintheEdit
menucanbeusedtoavoid
retyping the variable
narres.

Notice that multiplication
is w and division is “/“.

hpmts:o Fwl~tlm FmlPftce
0 flw mlesper(irllon
0 WV Mila per war

Ir)mta:O  Fulgrlcr FuelPritr
0 mu mloprGdlon
0 MPU mla par war

3 Click on the diagram icon
towturntothediagram.

Port3 Creating a new Demos plojrct
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1 Doubklick on the “Fuel
Ri&nodetoseeitsobject
window.

Probabilistic definitions and distribution
display
Demos excels at analyzing models with uncert& inputs. We will document
the variable Fuel price and give it a probabilistic definition. Let’s assume that
thePriceperCallonofgasisnot~wnforsure,ahduncertaintyaboutitis
expressed as a normal distribution with a mean of 1.19 and a standard
deviation of .lO. You will learn to enter this definition and request a display of
the distribution computed automatically by Demos.

Demos automatically gives
a new variable a default
namebasedonthefirst10
clumcters  of its title, when
you fint title the variable.
We will change this first.

A Note: the definition of
variable Fuel cost refers to
variable Fuel~rice. Demos
will automatically update
the definition of Fuel cost
whenyouchangethename
toPrice.

3 To complete the
documentation for this
variable, enter the units
and descriptionas shown.

We will edit this vuiable’s
deEnitionnext

C-238
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.

.

The distribution of Fuel
Rice should look like the
graph shown on the right.

Itisimportanttoenter
definitions correctly so that
Ikmosknowshowto
interpretthern.Toleam
molPaboutthepmper
syntax for a definition, refer
tothekmosQuick
Rtzkmwe. For mw, type
the normal distribution as
shown,using~theses.
Press Enter.
To display the distribution
of “Fuel Rice”, select
Probability Density from
the uncertainty view
sekxtor  popup menu.

6 Click on the diagram icon
tonztumtotheoriginal
diagram.

Part3

tlor: Prkaof~~llon  ofwllm

Creating a new Demos project
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I 1 Cl.ickonthe”MPG”
variable, to select it.

2 Inordertodesaibethe
attriitesoftheMilesper
Gallon variable, we will
open the attribute view.
Click on the expand icon.
Notice the attriite view
appearsbelowthediagram
nlisviewcanbeusedto
enter or edit data.

3 Siklick here to enter
thedescription Type
“Average number of miles
yYi&;tL-- bY car.”

.

4 Presshere toseethe
attriite popup menu.
Dragthemousetotheunits
attribute and release.

Entering attributes through the attribute
view
You may prefer to see the attributes and the diagram in the same window.
The attribute view (appearing under the diagram) allows you to edit attributes.
You will learn to enter data through the attribute view.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
\ of HI180 pr 6dlor:

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
4Oescrtptlon @I rnle8 par 6all.m:

‘;; OefinitionA- Uelue sprgrllonobtrimd byrarj 2

Probuslue
outputs 0
lnauts P
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Entering a definition in the attribute view
.Entering a definition in the attribute view is exactly the same as entering it in
theobestwindow. WewilldefineMilespergallonasanunoHainty
dbtribution,  where we believe it is equally likely to be any value between 20
and 30. You can use a Uniform distribution to characterize this.

The warning icon and
expression type popup
menu are available here
when showing the
Definition

The uniform distribution
increases sharply at 20
milespergallon,thenisflat
(has equal probabiity
acrossthisrange),and
thenfallsbacktozelu
probability at 30 miles per

[a Probability Denslty l Miles per Gallon (miles/gallon)  m

Part3 CreatingancwDemorproject
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Probabilistic results

1 Click on the fuel-t n&e
to select  it.

2 Select probability Density
fromtheunc&ainty view
selector popup  menu.

Demoswill takf2amomfznt
tocomputetheresullsand
display them in a graph.

This graph shows the
probability density of the
value of Fuel cost.

The graph appears “noisy”
becau*weareusinga
sample size of 100. Using a
larger sample size would
produce a smoother cum,
but it would take longer to
compute.

3 select cumulative Dis-
triiution from the I
uncertainty view selector
POPUP -u.

This graph shows the
cumulative probability of
the value of Fuel cost.

Demos can display the results of probabitic  inputs in several ways. These
indude probability density distributions and cumulative probability
diSbibUtiOns.

m Cumulatiue  Probability l Fuel cost (t/year) BZiZESR

C-242
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1 se!lecth4ilespe!ryearinthe

tixz.zzrnz
NormalO2K,2KI. Press
Enter.

2 Thel’robabilitydensity
option in the uncertainty
view sektor  popup menu
should already be aekted.
Clickontheiconhenzto
compute the probability
density for Miles per year.
If Probability density is not
already selected, select it
from the popup menu.

The probability density of
MiltSperpdSShOWll
here.

Refining the model
. Inlknos,youwillhditeasytorefineyournuxiel.  Youcanchangea

definition, add new variables and dependendes without having to change
other  parts of your model. Demos will autmaticauy  update the necessary
vaxiabkts  whose definitions or dependencies  have changed, and will
automatically recompute them when you display their values. In the car cost
model,werealltethrtwedon’treally)mowhowmanymilesperyearthatwe
drive,butwebelievethatitismost~ybobeauearlierringle-number
estimate of 12K, and we believe that a normal distriition with standard
deviation of 2K, or 2CW miles qreaents our uxertahty about its value

Deftrlttrr v rlr 8f Ill188  per *r:

m Probability Denslty l Miles per yesr (miles/year)  -mE

Part3 Creuting a nw Denwr pmject
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Importance analysis
In this car cost model, lik most Demos models, we have defined several input
variables as unoertaih  It is interesting to know how much each of then?
uncerth  inputs contributes to the uncer@hty  in the output. Importance
analysi.sisdescribedonpage21inPart2ofthistutorial.  Wewilllearnhowto
set up a simple importance analysis on our output variable Fuel cost.

y?Gi&h- , .4

IF

a
w

Wewillnowusethe
Importancefeatureof
bmos to automatically
generateanimportance
analysis.

a

L 
b fmrapr

g$i:iil-l yi. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .w.igiiii
Lkmoswilltakeafew
moments to figure out
which inputs are uncertah.
mitwillcreatea
variable, Fuel cost inputs,
that lists thew inputs, and
another variable, Fuel cost
impor-tane,  that computes
the absolute value of the
rank-order correlation
betweeneachinputandthe
value of Fuel cost

Moue Into Parent

Thenewnodesappear
toward the upper right part
of the diagram window.

3 Click on Fuel cost
importanoE to SeIect it.

4 Select h4id value from the
unety view selector
POPUP -u.

Diagram l Car Cost Model

IPI4
la

cc 7- P . - a
I r”“,p’ t-,I Ful cost I

a . . . . . . . . . I....................... I
C-244
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This graph shows that
MW,MiieSperyear,bti
variable c0ntributing most
OfthtZUncertaintyhthe

output M cost.

WewiUnowperfom

I 5 Clickonthediagramiam I
torehmtothediamam. I

m Mid Ualue l Fuel cost Importance B
x Axtr: Fwl crrt Irprtr

Part3 Creu ting a nrw Demor project
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Parametric analysis
Pammetric analysis UMXUU varying the value of an input Variable to ewlrnine its
effect on a sekted output. it often gives useful insights into what’s important,
and how a model behaves. Because the importancx analysis revealed that the
Miles per year aontributes  much of the uncertainty in Fuel cost, we will start
the paranu+c  analysis with that input variable. We will change its definition
from a probabiity distribution to a list of alternative values. Demos will then
graph the corresponding values of the output.

I“

1 ClickontkMilespefyt3u
nodetoselectitandview
its Defmition in the
attriite view.

Wewillnowspefifyh4iles
peryearasalistof
altemative values, of 8K,
12K and 16K.

2 Press on the expression
type popup mu, drag the
xlwuse to list and release.

\7 Demos Question 3 Since we want to change
the definition from a
distribution into a List, we
click Yes here.

Replace current deflnltlon with (I list?

A Nolqmsshgthe~etum
keywilIdothesame

C-246
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Anewcellwillappear
whenyoupresstheretllm
keyinthelastcelL

5 Repeattheprwiousskp,
entering 12K.
Inthehstcell# typew,
butthistiuqpressthe
enter key so it won’t add an
additional cell.

The mid value shows the
linear relationship between
milesperyarandthefuel
cost. lh3-e is a computed
value for each

value of

7 Click on the Table icon to
view the table of values for
Fuel cost

Part3

. . . . ...“....

p

I I /. . . . . . . . . . . . . . . . . . . ..f....................................................................................
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Here are the individual
mid values of fuel cost, for
each w value
of Miles per year.

8 Select Cumulative density
fmmthewxrtainty view
selector popup menu.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . I I. . .

This graph shows a
cumulative distribution of
Fuel cost for each

vahle of

9 Clickonthediagramicon
toretumtothediagam
window.

Mid Ualue l Fuel cost (S/year)

--Iwl&mlwpor~r(rlla/ge8r) q
-I- - I

380.8 I I

1-U Cumulatiue Probablllty l Fuel cost (S/year)  m
KS& tllloa per par (alln/wrr) 7
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Creating a submodel

L

1 You must be inkit nxxie
to cm&e a submodel. Click
hemifn#lessary.

2 Click on the Subnrxiel  icon
anddragtheoutlineofitto
tkpositionshowninthe
diagram Noticethat
Submodel node have thick
outlines. Title&e
submodel vuelcost
Inputs”. Press Enter.

3 Tomovetheimportance
variables into the
submodel, select both of
their nodes.  Fhess and drag
the mouse to surround all
three input variables.

Asyoudqthemouseto
the right to surround these
variables, your diagram
willxrrOlltotht?left#and
thescrolltarthumbwill
move toward the right.

in order to simplify complicated dif~grams,  submcxiels CM be created. Perhaps
we would like to create a submodel that contains  variables used for analysis,
and include the Importance variables that we pnzviously created. We might
also create subdels if we decide that our Puekast dekrmination is a small
partofalargermodel. Youwillleamtoaeateasubnx&landplacenodesin
it.

m Oiaomm l Car Cost Model c__I

\’ai. . : : : : :

. . . . .

Part3 GeufinganmuDcmorproject
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4 Pressononeofthesenodes
anddqitintothe
SUbmodel.

scrollthediagriKnbaclc
toward the right by
pressingonthescmllbar
thumb ad dragging it all
thewaytotheleft.

‘Ikfinalappeamneisas
shownhere.

56
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Saving your model and quitting
Afteryouhavecreatedpartorallofamodel,youmaywanttosaveit.  When
you have finished a session with Demos you may want to save and quit.

1 To save your mod4 s&c4
Soue from the File menu.

Open ProJecl...

NOIU Tat I1N
Open... SO

CIOSII uw

A Note: You may also select
Quit from the File menu.before Fememberrng to save

you this dialog box.
I I

I Ssue As...
SWB I Copy In...

 Demos auestion

Save changes to your model before quitting? -

(Cancel) [NO) r/z?]
12 Click Yes to savechanges. I-
L I

You have previously roved
your model under the
name Tar Cost Model”
beepage34,soDemos
now automatically saves
yourchangesinthatsiune

New f’l’ojec t
Open PtO]BCt . . .

New TeHt #N
Open... #O

Close alJ
Close ProJect
Ssue SS
Save As...
Ssue a Copy In...

lmpor L..
ENpoll . . .

Page Setup...
I Pflnt... %P

57Part3 Creafing  a new Demo8  pmject
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Reopening a Demos project

1 Doubkxlick on the Demos
folder on your hard drive.
If you have amtinufzd  from
the previous page, this
folder is still opened.

After saving a model and quitting, you may wish to open the model again to
look at it or to make changes to it.

. ** . . . . . . . . . . . *. . . . . . . . . . . .*.  . . . . . . . . . . . . . . . . . . . . . . . . . I

2 Doubkxlickon the Demos \

A Note: You can alternatively
double-click on the “Car
Cost Model” icon.

3 Locatethemodelyou
wouldliketoopen,inthis
case, Tar cost Model”.

4 Doubkxlick on the “Car
Cost Model” model or
single-click and then click
open.

You should IU)W see the
“Car Cost ModeV diagram.

i

.

.
.
ii
?!

.

/

Select end open an eHfttlng proJect, or click New
to start a new proJect.

Ih
0 Release

[EJecl]

Part3



SECTION 4.0

DEMOS QUICK REFERENCE GUIDE

C-253



hi!9 D e m o s
I” Quick

Reference

ILumha
Deision Systems, Inc.



Copyright notice
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Macintosh windows
The window shown here is a Macintosh folder containing the Demos pro- in just the same ways as the folder window shown here. On the other
gram (also known as the Demos application) and some Demos models pages we will describe only those buttons, menus, and other features spe-
(also known as documents). The controls described here for moving, scroll- cific to Demos, and we will not repeat the explanations of the standard Mac-
ing, r&zing, and closing this window are the standard Macintosh methods. intosh features shown here.
The Demos windows described in the rest of this manual can be controlled

Tttle bar: you can drag this (or any)
window around the screen by pressing
the mouse button in this area and mov- /

Close box: click on the box to ing the mouse.

make the window disappear.

\
Name of this folder.

I /

Zoom box: click it to en-
large the window to the
size of your screen. Click
it again to revert the win-
dow to its oriiinal size.

The Demos Appllcatlon:

?
to start a new model, double clidc

E

on this icon (see pages 2,3,  and 12).

Demos model documents: these
are text files containing models.

To restart a Demos model, double

\h
! II . f Demos folder * 4/

2=
33.1 MB tn dtsk 24.4 MB avail&h Thumb box: drag the

I Demos Hey ? TX; AcccuntinglbwyI
f.q.i:j/iii;

Up arrow: press on the
arrow to scroll the view
upward.

click on its icon (see pages 2 and 4).

A Demos Ilbrary.

the box to move the

arrow to scroll view left (the
document moves right).

in this area to jump

arrow to scroll view right (the
document moves left).

box to mOve the view up
or down.

Vertical
scroll
bar

Down reglon: click in the
area to jump the view
down.

Down arrow: press on
the arrow to scroll the
view downward.

Grow box: Drag to
change the size or shape
of the window.

Hortzontal scroll bar
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The Demos startup progress box 2
While Demos is starting up, it displays the upper box. This box tells you one shows you its progress in checking the model to see that the model is
which version of Demos this is, and provides licensing information.  The well formed. When the model is ready, Demos will display the diagram win-
progress bar shows how far Demos has gotten in initializing. If you are start- dow for the top model (see page 4). If instead, you started Demos directly,
ing up an existing model, Demos will display the two tower boxes next. The e.g., by double clicking on the Demos icon, it. will go to the open model file
middle box shows you its progress in reading in the model file. The bottom dialog box next (see page 3).

Startup progress box

Version of Demos, and date
it was released.

Llcenslng InformatIon

IIlhmlm a decision modeling system

Vertion 1.7bB FPU of Hey 13, 1992

Ql982-91 Cerrqie Mellon University
@I 992 Lumine Decision Systems, Inc.

Early Adopter Beta Rtleese - for Licensee use only.
Demos mey not be copied, sold, lent or otherwise provided
to anyone else. Contect  Lumine Decision Systems for more
information, wsistsnce or to obtain a demonstration copy.

Brian Arnold
< Lumina Oecislon Systems
Initializing... I

“i
Silnnlng ball cursor: lets
you know Demos is doing
something.

/
Click on the Stop button to
interrupt file reading. It willName of YeI file

/ then ask if you want to con-

Name of variable whose definition
is being checked.

Model checking box:
the bar shows its progress
while checking an existing

model for any syntax problems.

:i Checking Definitions... 
\

Checking: Selling-cost Click on the Stop
button to interrupt..

I ( stop



The open project dialog box 3
This dialog box lets you open an existing project or start a new one. You will start, select ft and click the Open button. As an alternative, you can simply
get to this dialog box after seeing the startup box on page 3, if you started double click on the file name. You will then see the model reading progress
Demos by double clicking on the Demos application (see page 1). You can bars shown on page 2. After reading in the model, Demos will display the
also get this dialog box by selecting Open Project from the File menu diagram of the top model (see page 4). .
(after selecting Close fmm the File menu to close the current project).

If you want to start a new project, then simply click the New button. It
If you want to restart an existing model, use the folder popup menu and shows you a new project object card (see page 12).
contents list to find its file. Once you have found the model you want to

The list  of Demos models and
folders in the current folder.

House Is the selected file.

Click once on any other
file to select it.

\
To open a folder and see

what is in It, double clidc
on the folder.

The current folder: press on the folder button
for a popup menu of the folders containing it.

/ /

The name of the disk contain-
ing the current folder.

Click on this button to eject
this disk. (Dimmed if it is not a
diskette or other removable
medium.)

Click on this button to make
the desktop the current folder.

Click on this button to close
this box without opening any-
thing.

Click on this button to start a
new Demos model (see page
12).

-Click on this button to open
the selected folder or Demos
model. Opening the model file
will read ft in and display the
diagram of its top model (see
paw 4).



The diagram window in browse mode
This window depicts a model as an influence diagram. Each node is a vari- This diagram is in browse mode. In this mode you can inspect the model
able or a submodel. Each arrow depicts an influence, that is, a direct func- and evaluate it in order to generate tables and graphs. If you want to
tional  or probabilistic dependence of one variable on another. change the model structure or add new variables, you must enter the edit

mode (see page 13).

Click on this icon to go to the
parent model diagram. If there
is none, this icon is grayed
out.

/ ,A selected node is indicated .
I Click on this icon to view the / by highlighting.Click on the hand icon to go into

browse mode. It is grayed out
to show you are already

in browse mode.

Click on this icon to switch
to edlt mode (see page 13). \

Click on this icon to view the \
value of the selected variable

with the selected uncertainty \
view option.

Press here to see the popup menu /
of the uncertainty view options:

/I Mid Ualue
m Mean Ualue
mi Statistics
l& Confidence Bands
h Probability Density
IL Cumulative Distribution
E Sample

L

I object window of the selected
node (see page 6). Title of this model
/ /

3 Diagram l House cost analysis i --
/

To select a node, single click
on it.

To see details about a node,
double click on it. E.g., double
clicking on a variable will dis-
play its object  window (see
paw 6).

To deselect all nodes click the
diagram anywhere outside any
nodes.

\ A hexagonal node depicts the
crlterlon or objective of the de-
cision model, e.g., net benefit,
cost or utility, or whatever you
are trying to maximize or mini-
mize. Most models have a single
criterion node.

declslon variable.
A thick outlined node depicts a

Choose one to display the value Click on this key Icon to see the A rounded node ‘depicts a chance submodel, containing variables
of the selected variable node. attriie view below the diagram, (i.e., uncertain) variable. in an influence diagram of its own.

showing more information about Double click on the node to see its
the selected node ( see page 5). diagram.



The attribute view 5
The attribute view is a pane that extends below a diagram window. It lets and select one to inspect. Select another node to see the same attribute of
you view any attribute of any node you select in the diagram. Click on the that node. You can edii an attribute in the attribute view, provided the
key icon 0 to display the attribute view. Click on the node you wish to select. attribute is user-modifiable.
Then press the attribute popup menu to see the list of attributes available,

4Descrlptlon

Select the desired
anribute from the menu.

==t Diagram l House cost analysisThe selected node whose
attribute is displayed below.
To select  another node, just

Click on this key Icon again to
close the attribute pane.

The current attrlbute:
To select another attribute,

press the mouse to see a
up menu of available attributes.

Drag this partltlon up or down to
change the heights of the diagram
and its attribute pane.

Note: dragging the grow box
changes the size and shape of the

1 I I I \ diagram, but the height of the at-
I

The contents of the current at- tribute view remains fixed. Drag the

tnite of the selected node are
Title of the selected object. partition to change it.

shown here. You can edit it if the \
attribute is directly modifiable Click in the field, and the gray out-
(rather than computed by Demos). line will show up if the field is edii-
For editing a definition, see page able. When done, press the enter
18. key to store changes.



The object window 6
-B

The object window shows all of the attributes of an object together. You can c lYou can see the object window by clicking -- in a diagram window (see
edit any user-modifiable attribute directly. Inputs and outputs are not user- page 4) by double clicking on the object’s node in its diagram window (see
modifiable, since they are generated by Demos from the influence links or pages 4 or 13), or by double clicking on the object’s name in the browser
definitions of the variables. (see page 10).

Class popup menu

ml

The node shape and the name show the node class of this
object. You can change the class with the popup menu that

dzqears when you press here.

This is the variable’s title, as it appears in the
node in the parent diagram. The title can occupy
up to 36 characters or 3 lines.

/

\

This is the variable’s name, as used in mathematical
expressions. It must start with a letter, have no more
than 20 characters, and contain only letters, num-
bers , I.*, a,nd “,” (used instead of a space).

/
? model diagram. If there is none,
E this icon is grayed out.

The unlt of measurement

P
Clii on this icon to view the o t Object l Annualized houslng cost * P

ject wlndow of selected node.
The icon is grayed out because it

is the current window shown.

~Objettive Nddiff

Click on this icon to view the
value of the selected variable
with the selected uncertainty

view option.

Press here to see a popup menu
of the uncertainty view options.
Choose one to view the value of
the selected variable
paw 4).

youtpate: Impertence , (rent cerrtletion) v

I

A list of the variable’s Inputs, I.e., the variables and func-
tbns appearing in its definition.

Deecriptien: The net annufJized difference Mveon buying and renting a house,/
including everything I can thinkof.

Definitier:  Ann-profit  - Annual-how0 I

Click on any of these text
fields to edii the attribute. The
dotted outline shows that the
attribute

/

is ready to be edited.

Click outside the text field
again or press the enter key
to accept the modified text.

-The descrlptlon  consists of
text explaining what this vari-
able represents.

The deflnltlon type popup
menu. See page 18.

-The deflnltlon is a number,
probability distribution, or other
mathematical expression from
which to compute the value of. - .- _

Presi in the area shown to display a popup menu of the this vadabte.  See page ‘8 tar
variable’s outputs, i.e., the variables and functions in an explanation  Of how  to SWC-
whose definition this variable appears. ify or change it.

Double-click on an input to display that input’s object win-
dow in the place of this one.

Select an output from the menu to display the output’s
object window in the place of this one.



Values in an object window
You can show the mtd (i.e., deterministic) value of a variable and each of its value as a table or graph.
inputs in that variable’s object window. This is often useful for checking if a
definition is calculating what you intended, and for finding mistakes in the To see these values, first click on the object window to make sure it is
model. If a value is a table rather than a single number, it will show a active. Then select the Show Ualues option from the Object menu.
Show Value button instead of the value. Click on this button to display the

The value of the current variable y
is shown here.

This Is a list of Inputs, with their units 
and values. Double  click on an input to
see its object window in the place of this
one. lt will also shows the input’s values.

 ObJect l Net annual house cost 
>ChWlCG! Annual-house Units: t/year

c-

.  .  ..----...
Tltle: Net annual

house cost” ..-.....  -
Dercrfptien:  Net annuel cod of howe taking into account annual payments, property

taxes, maintenance, insurance, receiving rent, and tax deducttom.
excluding appreciation or house and loss or Interest on DownPayment.

Deflnitian: Payments l PropertyAx + Maintenance + lmursnca - lax-red -
House-rent - Curr-rent

Velre: 10.85K

Curr-rent Current rent (S/year) - 9420
0 Howe-rent Rent from howe (S/year) = 8400

Insurance ($/year) - 600
0 Msintena... maintenance (S/year) - 4000

Annual payments (S/year) - 30.741:
0 PropwtyA.  Property taxes (S/year) - 4 6 0 0

Reductfon in taxn ($/year) - 11.26K

Drtputs: Annualized heari~ teat v



The graph window 8
A graph is a representation of a table value. The vertical (y axis) shows the
values. If the graph has one dimension, the values of the dimension are
shown horizontally (along the x axis). If it has two dimensions, you can
choose which index goes along the x axis, and which is in the key, produc-
ing multiple curves. For an array with more than two dimensions, you select
a two dimensional slice, using the popup menus at the top.

You can display a graph by clicking the view button, or by selecting an
uncertainty view option in a diagram or object window. If the graph window
shows a table, you can (usually) change it to the corresponding graph by

Third dlmenslon Index: the Double click anywhere in
title(s) of the other index vari- the graph to get the graph

able(s) if the table has setup dialog box .
3 or more dimensions.

\
0 Click on this icon to go to the parent

lb diagram containing this variable.\ Mid Ualue l Annualized housing cost (
rglnq prier (SK) b

i% Click on this ‘con to view the object,
window of the selected node.

This icon indicates the uncertainty/
view option displayed

in this window.

Click on this icon to change the
uncertainty view option and to view

the value in this window.

Click on this icon to view the
table for this variable.

The graph icon is grayed out
because you are viewing a

graph of this slice of the table.
/

clicking the graph button. On a color monitor, each curve is displayed in its
own color.

Select Graph Setup (see page 25) from the Graph menu to change the
view (x and y ranges), graph size, and three dimesnional view. Select
Graph Styles (see page 26) from the Graph menu to change the frame,
grid, and line forms, plotting symbols, and other options. You may also
select Graph 3D Effects to control the display of the three dimensional
perspective (see page 27). But this is not wofiing proper/y  yet.

The title of the variable whose
value is displayed here.

\

This field shows the value of this
Index variable for the two dimen-

\ sional slice currently being graphed.-

2SK 1 \..*

20K-

1SK.

lOK-

5000  -I

Annual  appreciation (Iyear]
Yeus l vned (years)

:
10 le

\
y axls ’ This key shows the value of the key index variable x ails

that corresponds to each curve, indicated by pat- -
tern or color.

\
Drag the grow box to expand or contract the graph.

-Press on tt to get a scrolling list of all
the values you can select from.

Key Index: the title of the index vari-
+ able for each line in the graph, as

specified by the key below. This title
nly appears if the value has two or
more dimensions. Press this triangle
to show a popup menu of index vari-

\

ables to select from for the key.

X AXIS Index: the title of the index
variable along the horizontal edge (x
axis). Press the triangle to show a
popup  menu of index variables to
select from.
For example,



The table window 9
The table window displays the value of a variable which has one, two, or If the value has two dimensions, you can pick, from popup menus, which
more dimensions. You can display a table by clicking the uncertainty view index is displayed horizontally, and which one is displayed vertically. If it has
button in a diagram or object window. If it shows a graph, you can change it more than two dimensions (this one has three), the table shows a two
to a table by clicking the table view ‘con. Each dimension is identified by an dimensional “slice”. The popup menu(s) at the top.allow you to select which
index variable. slice to display.

The title of the variable whose
value is displayed here.

The current value of this Index for
Click on this icon to go to the this “slice”. Press in this field to get a

parent diagram containing this popup menu of all the values you can
variable.

?
K Click on this Icon to view the
NJ object window of selected node.

This icon indicates which
uncertainty view option is
displayed in this window.

Press the triangle to see a popup
menu of the uncertainty view/

options (see page 4) . Choose
one to apply that option

to the values.

Table vlew button: this icon is
grayed out because you are viw-

ing the table for this variable.

Graph vlew button: click on this
icon to view this table as a graph.

*This field shows the title and
units of the index variable for
the vertical dimension of the
table. Press the mouse button
to show a popup menu of the
index variables you can
select.

.This fietd  shows the title and
units of the index variable for
the horizontal dimension of
the table. Press the mouse
button to show a popup menu
of the index variable you can
select.



The browser
This window shows a scrollable alphabetical list of all the objects inside a
model. Click once on an item in the list to select it. Click twice on a model to

Select Browse from the Object menu to see this window.

browse it, or click twice on a variable to see its object window. You can also
see and edit attributes of any selected object in the attribute view at the bot-
tom of the window.

Click on this kon to display the
parent diagram. This is grayed

out if the current window\
/This is a list of variables, sub-

models, functions, and other ob
jects in the current model. Click
on an object to select it.

displays the top model.

Click on this icon to open the
object window for the selected

object (see page 6).

Clii on this icon to view the value
of the selected variable node in

the selected uncertainty
view option.

Click on this icon to change the
l over tha contract period <bow Inflation),

suaing  no impravments.,
uncertainty view option and to
view the value of the selected

variable node.

AttrIbute  popup menu: pressing
on this box displays a popup menu

of attributes, from which you can
select any attribute to display.

This fiel!f describes the current contents
of this attribute of the selected object. If
the attribute is user-soecifiable, YOU can

I Units edit it directly, by clicking in this text field.
4lescription

Ualue
outputs
Inputs

-The selected object is high-
lighted.

‘Double click on a model to see
what is in it. Double click on any
other object to see its object
window (see page 6).



Managing windows 11
It’s easy to end up with an enormous number of windows cluttering your moves the one you asked for to the top. %u can also select Bring to
screen. The best number and arrangement depends on the size of your front from the Window menu to see the current windows and select
screen(s), what you want to do, and your personal taste. which one to display on top.

If you ask to show a window (object,  diagram, graph, or table) that is
already on the screen, but pernaps  hidden under other windows, Demos

Diagram windows If you find your screen over crowded, you can
always close any window by clicking  in its close

When you open the diagram window for a submodel of
your current model, tt will create a new window, leaving
its parent window on the screen. However, if another
submodel  of the current diagram is already displayed,
it will replace that by this submodel. Thus, Demos
encourages you to have not more than one diagram
window open for each model level open at any one
time.

0
E But if you want to see together two “sibling” diagrams,
CD i.e. models at the same level, press the Command key

when you double dick on the node (or other button) to
open the second diagram. This will create a new dia-
gram without closing any existing one.

Object wlndows

You can open an object window:
1. By clicking on its node in its parent diagram, or
2. By &king on the inputs list, or
3. By selecting from the outputs popup
menu of a linked object I

If an object window is already displayed, it will displa
the new object in that window. Otherwise, tl will create
new object window. But if you press the Command key
while clicking to display the object, it will create another
window. Hence you can display two object windows at
once.

DcstrlpHor:  Net profit converted Into quhlent  quel mud mounts udrq
bpecifled discount rate over yews of owing the house.

DefinlHon: Profit l Annuelln(dixount, years)

Inprtr:  D Annwltm  Annualize



The project object window
The project object window shows information about the project, such as its
author(s), creation, and save dates, as well as a description. When you start
a new Demos project, it will show an object window for the new project, ini-
tially untitled. You should start by filling out the name and/or title fields and
the description. Enter your name into the author(s) field. The creation and
save dates, and the file name are filled in automatically.

12
Behind a new project window is a Mat-k diagram window. When you have
finished entering information into the the projed window, bring the diagram
to the front by clicking on the diagram button, or anywhere on the diagram
window. You can then draw a new diagram for the model (see page 13).

A project may contain several models, modules, or libraries. Each model,
module, and library has fts own diagram, and also its own object window

Ybu can start a new projed by &king the New button in the file dialog box
on page 3, or selecting New ProJect  from the File menu.

looking much like this project object window.

Dtagram button: Ctii on this icon The class of this object. The tltte of this model. It can
to show the diagram window. to see a popup

f model classes.

The descrlptbn can accommo-
? date one or more lines of text The name of this model. It (or name if no title) becomes

2: describing what this model is for. e of these windows.
0

This field contains the name(s) of
the author(s) of this model. Edit it if
you don’t wish to use your comput-
er’s Chooser name.

This field displays the date this
model was first started. Darcriptior:  To demonstrate and test creation of a Dam modal.

This field displays the date this
j.. ‘~‘Arthw(a):~  Henrion -“--“-
b

model was last saved into a file. n . K_ ‘Crmtd: wad, Apr I, 1992 928 PM

is left blank if you are currently + iart Swed:
working on a new model.

- -
File Info: 0 (notsavadyet)

The file Info attribute descnis the >-
file name, folder, and disk contain-
ing the project. 1%

Note: These dates and file info are Click on the diagram window behind the
generated automatically and can- object window to bring it to the front so you
not be edited. can create a diagram.



A diagram in edit mode 13
This diagram window is in edit mode, so you can create new nodes, and
move or modify existing ones. When a diagram window first opens it will be

for an explanation of how to copy and paste nodes. See page 15 on how to

in browse mode (see page 4), so you can examine, but not change, the dia-
draw arrows. See page 14 and 32 on how to reformat and tidy up diagrams.

gram. You can switch to edit mode by clicking on the edit tool. See page 14

Click on this icon to see the parent diagra

Workfng wtth Nodes

Click on the arrow icon to enter link arrow
mode. The cursor changes to a

right arrow (see page 15).

Node menu: clfck on one of the icons to
create a new node of the selected

type. Then use the keyboard
to enter the node’s title.

Click on this kon to view the object
window of selected node.

Click on the hand icon to switch
back to browse mode.

POP Diagram l House cost analysis *
y.>
-?Etz-

The edit tool is grayed out to show
you are in edit mode.

 I’::f ‘:‘.l’:::l...,....:.:........: . . . . . . . . . . .,.,.,.  : : :., : :i .‘:::::.  .,_,. .,..,..  .,.,.,,““:‘:‘::i;‘:‘:i:i:i:i:i:i:i:i:il!:1:.:~,~:~~~: i:i:iii:i:i:i:i:l::.:_.....::::i::::!::::jlj/i:i::.:::::::::.::::::::  yy.:,:... .._.......:  ._._..._.......,.,.,.,.,.......,  ..,._..._.  ._......._  ._._....__.(........  ,.. : . ““:““:::::::‘:‘:~.~:~~~~.~:~~i!~l~~:~~~~~~~?~,’:~~~,~~~~.~~~~~~~~:~:  ,,,,,,,,.,_,,,.,_,,,  ,,___,,_,,,,_,_,_,.  _,,,,,__,,,,  ,,,,,,,,,.I.!::.:....:..  . ..._..,.  . . . . . . . . ,,.,, ;;

To1 move a node: simply drag it
by any part other than a handle.

Toselect a node: single click on
it.

Handles indicate that a node has
been selected.

To change the sfze and shape
of a node: drag a handle until the
node is the size and shape you
desire.

To open up the object wtndow
of a node: double click on the
node. See page 6 for details on
the object window.

T’CJ  deselect all nodes: Click
anywhere except on a node.

To delete the selected node(s),
choose Delete from the Edit
menuorpressthedelete  key.
Demos will ask for confirmation
to make sure you really mean it.

To edlt the title of a node, first s......................................
select it, then click on its text. It will

+
: :

look like the illustration to the right. i : .
;: 1

. . .:
When finished, the node will be \
automatically resized to fit. : .

, -:

Hint: Leave a little pause between
the click to select the node and the
click to select the text to avoid hav-
ing Demos intepret it as a double
click, which will open up its object
window.



More advanced editing of diagrams 14
Additional commands available for the diagram window in edit mode are
selecting mutliple nodes and copying and pasting nodes.

Other editing options including diagram and node style preferences are
found in the Diagram menu. See page 32 for details.

To select multiple nodes: either single click on a
node while pressing the shift key to add the node to
the set of selected nodes (or to remove it if it is
already selected). Alternately, drag a rectangle,
using the cursor, around the nodes you wish to
select in order to select all the nodes inside it. You
can drag all of the selected nodes as a group.

ZllB Diagram l House cost analysis VIJJ

I
�---Y--/ y ; ;

. l

. . . * . . . . . . . . Interest . . . . .

:a

rate
. . . . . . . . . . . . . . . . . . . . . .

. . .

Copylng and pastlng nodes:

If you want to make nodes with a lot of information in common,
To paste a selected node from the clipboard into this diagram

you can use the traditional Macintosh copy and paste options.
window, select Paste from the Edit menu or type 8-Y

Initially the copies will be identical except for their names which
may have numbers appended to make them unique.

You can also paste nodes (the entire graphic representation

I including arrows) into MacDraw, and similar graphics applica-
tions.

To copy a selected node into the clipboard, select Copy from
the Edit menu or type 842.

To cut a node (and its object window) into the clipboard, select
Cut from the Edit menu ortypege-X



Drawing arrows in a diagram window 15
When a diagram window is in arrow mode, you can draw or remove arrows
(influences) between nodes. You get into the arrow mode from the edii
mode by clicking on the arrow kon + in a diagram window (see page 13).
If the diagram is in browse mode, you must first click on the edit button 4 to
go into edit mode (see page 4).

When you draw an armw from a varfable node A to a variable B, Demos will
create the definition of B as “FunctionOf(A  This means that B is some, as
yet unspecified, function of A. If B already has a specified function, it will first
ask if you want to change ft. Drawing arrows from other variables into B will
add them to its definition. You can then edit the definition of B to specify the
fan of the function. If you type in the names of additional variables into the
definition of B, or remove variables from it, arrows will be automatically
drawn or removed to refled these dependencies (see page 18).

If you try to draw an arrow from a variable into a submodel  (or from a model

into a variable), Demos will ask ff you want to create an alias of the variable
inside the submodel. See page 17 for details. You can also link variables in
different models by temporarily moving the variable into the same model.
See page 16 for more information.

A cyclic dependency occurs when a variable depends on itself directly or
indirectly, so that the arrows form a directed circular path. Demos will not
allow cyclic dependencies except in dynamic models; it will warn you il you
try to create one.

In a dynamic model it is possible to have cyclic dependencies provided vari-
ables depend on their values in an earlier time period. Influence arrows are
not displayed for dependencies on an earlier time period, and so even then,
no cycles will be visible. See Chapter 18, “Dynamic Simulation”, of the
Demos User’s Manual for details.

This kon is grayed out to show
that you are in arrw mode.

\
To draw an arrow: Move the cur-
sor to the origin node and press
the mouse button. The node will
be highlighted. Holding the but-
ton down, drag the line to the des-
tination node, which will also,
become highlighted. Release the
button and the amw will be
drawn.

To remove an arrow: Simply do
the same thing as ff you were try
ing to draw a second arrow over
the first from the origin to the
destination.

3 Diaaram 0 House cost analusls -E!El /A-s and M0de’ lWdes: An
amw from a node into a submodel
indicates that thtere is at least one
variable in the SIJbmodel depending

model to a node indicates that the
node depends on at least one vari-
able in the submodel.

L hcJ1 I‘m44
. . . . . . . . ..:.. . . . . . . .

jiii!ii:i)iii:jii:i:i::::.:::.::: . .._.. ,‘_‘,4’ :ii~~i::.-:!:::.:  II!:.:  ::!:i:iiiiiiiiiitiiiil:::i::::::  .:,:,.,,,,:,,-,-,,.,.,,  :4. . .,.I :.. I.:  :.::::::::::g:i:!,I  ! j..: ? “:‘.i:.....!i!!!::i::;:lti;i:::::liilir:~:~  :::::.::  ,.:2;2::  y:j:::_:.x :,_,..._.,.,,,.,.,.  . ..,...’ . Q’. ‘.1,1:1  :+:j:::4 :::,‘ii,!.iii,i::(I::
.:.:.: . . . . :...

:.a.1  ..,.:  . . . . . :,,.:  ..:.:,,.,.,.,.,.,,,.,.,.
_._..,... .,...,:  . . . . . . . . . . . . . f.fiii

A double headed arrow betwe& two nodes
means that each model contains both inputs
and outputs of the other model.

If you select muftiple  origin nodes
(click on a node holding the shift
key to add ft to the selection), then
arrows will be drawn simulta-
neously from each origin node to
the destination node.



Drawing arrows between different models 16
When you create a dependency between two variables in different models, be drawn automatically. This method is illustrated below.
an arrow will automatically appear between the models that contain them or
between one variable and the model that contains the other. But you can- Another method is simply to edit the definitions of the variables, typing in
not draw arrows directly between models, or between variables in different the names of the inputs directly. You may wish to choose Uiew by Name
models. If you want to link variables in different models, it is often easiest to from the Ob Ject menu (or type % -I) to remind you of the variabfe  names.
move the variables temporarily into the same model , so you can then draw The relevant arrows will appear automatically when the definition is
the desired links directly. When finished, you move the variables back to accepted. A third method is to use an alias (see page 17).
their proper parent models, and the links between the relevant models will

Example : Suppose we want to draw an arrow from the variable Years owned to the variable Se//ingprice  in another model.
/ \

.

Step 1: Moving the variables into the same /

model.
There are two ways to accomplish the move:
One way is to drag one variable (in this exam
ple, Years owned ) into the submodel  (in this

?
case, Capita/ cosfs)  which contains the other

rt:
variable. This is what is done in this example.

P
Alternately, you can move the second variable,
(Se//ing  price,  in this case) up into its parent’s
parent mode, by selecting it, and choosing the

\
.-ylagram l Capltal costs:

Move Into Parent command in the Object
menu. Either way both variables end up in the
same model.

i-3 Diagram l Capital costs:

Step 2: Draw an arrow between the variables.
Select the arrow tool and click on the first vari-
able (Years owned). Drag the arrow over the
second variable until it is highlighted and
release the mouse. An arrow is drawn from the
first variable to the second.

Step 3: Move the variables back ihto their origi-
nal models.
You first need to reverse Step 1. Select the first
variable node (Years owned) and choose
Moue into Parent from the ObJect  menu.
An arrow will appear from the first variable t
the submodel.

iDiagram l House cost anal&

L................................................~

This small arrowhead indicates thd

iU Diagram l Capital costs!
\

node has an input from another model.



Using aliases 17
When you draw an arrow using the arrow tool from a variable to a sub-
model, Demos assumes that you want that variable to influence another
variable in the submodel, so ft asks you if you want to create an alias of the
variable in the submodel. An alias is a reference to the original variable. It
appears the same as the original, except its title is in italics. If you double-
click on the alias, you will get the object window of the original object.

%u can also create an alias by selecting a node and choosing the Make
Was  command in the Object menu. You can then use Moue Into
Parent from the ObJect  menu to move the alias into the parent model,
and into other submodels. If you locate  an alias in a submodel  of the original
4

variable, an arrow will appear going into the submodel  even though the vari-
able doesn’t yet influence any variables in the submodel. Presently, you
cannot use aliases to represent influences coming out of models. If you
attempt to draw an arrow from a submodel  to a variable, or from one sub-
model to another submodel, Demos won’t do anything.

If you draw an arrow from an alias to second variable, a dependency is cre-
ated from the original variable of the alias to the second variable. II you
draw an arrow from a second variable to the alias, a dependency is created
from the second variable to the original variable of the alias.

If YOU draw an arrow from a varf- ?! , * Diagram l House cost analysis g

able to a submodel  as shown
here, you will be asked il you
want to create an alias in the
submodel.

Click Yes to create the allas  of
the variable in the submodel.

This is the alias for
Years owned, with its
text in italics. If you
doublecli i  on this
node, you will get the
object window for the
original variable.

If you open the submodel, the alias will
appear in the top-left comer of the window.

7 Dlagram l Hou\e  cost analysis 3

Although the dependency is ambiguous (and in fact no
dependencies have been specified yet with variables in
the submodel) Demos draws an arrow going in the sub-
model.



Creating or editing a definition
The definition of a variable may be a simple number, a text string, a proba-
bility distribution, or a more complicated expression. It can also be a list or

to select it, and type in the expression you want to change it to. See page

table of numbers, text strings, distributions, or expressions. The popup
38 for the syntax for numbers and simple expressions. After you have
selected the definition field by clicking in it, look at the functions menu for

menu above the definition field shows the class of the current definition, ini-
tially defined as an expression. You can inspect and edit the definition of a

lists of the various kinds of functions and operators that you can use in an

variable either in its object window, as shown below, or by selecting De f i -
expression. If you select an option from the functions menu, it will be copied

n I t I o n in the attribute view of the diagram (see page 5).
into the definition field at the cursor position. See page 39-45 for descrip-
tins of functions and operators in Demos.

If you want to enter a definition that is a simple number, text string, probabil-
ity distribution, or other expression, you can just click on the definition field

First, display the current definition of the variable. You can show
this in its object window (see page 6) or

attntte  view (see page 5).

If the variable has no inputs, its definition may be blank.’

If the inputs to a variable have been specified by drawing
arrows on the diagram,e.g.,

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
BWng

El
price

then the definition will look like this. This definition shows what
the variable depends on, but not the form of the dependence.

Click on the definition, and edit it using the standard Macintosh
text edit operators, select, copy (gg-C)r cut (as-X), and paste (gg-
V). If the inputs are shown in a FunctionOf()  form, you can edit
them to specify the expression without having to retype the vari-
able names. lf you want to be reminded of the names and
parameters of standard Demos operators and functions, select
them from the Librarg  menu. ff you select an option from the
Library menu, that function or variable will be copied into the
definition at the cursor position.

Bll- ObJect l loan ? ‘&
8 OChmcr Mortgage Units: $ 2

^...”  . . . . . . . .
- llsr Title: loan- n;ia

YIyyLvlyl
I Description: Total mortyaye  (loan) amount.
D WV

&,Drfinition:[fi&%onOf(  P r i c e  Duwnpayrh~-.---.- - - - -xl

Inputs: 0 Dovnpaymt Dovn payment
0 Price Buying price 0

PI

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ./ The definition warning sign : V
shows if the definition is not yet
syntactically correct. Click on

-7j-f- hnn,ti,n:  g$+-.----j
: . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .‘:‘:‘z:17......7:;:1-‘;‘:‘:

the icon if you want to see a . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
message about what may be i ’ WV
wrong. As soon as a variable iH Definltior:  ~-ZG&iiiii--~-.-.....-----. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .._........................
has a syntactically correct defi-
nition. its node in the influence . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .:-
diagram will go from gray to
clear.



Creating or editing a list 19
A list is an ordered set of values, numbers or text strings. The value of an for every value of A. So the value of B will be an array, indexed by A. The
index variable must be a list. It is also possible to specify a list as the defini- array can be looked at as a table or graph. It will show how 6 varies accord-
tion of a decision variable or chance variable, specifying the discrete set of ing to the value of A. This is termed a parametric analysis, and is often very
alternative values it can take. If you specify that the definition of variable A is useful. It is possible to specify lists as definitions of two, three, or more vari-
a list, then any variable B that depends on A will be automatically evaluated

To specify a deinition of a variable as a list, first show its
definition, either in the variables object window (see page
6). or in the diagram attribute view (see page 5).

Then presson the Expression type and select L I s t from
the popup menu.

If the variable already has a deinition, tt ill confirm that you
0 want to replace it. Click on the Yes button it you do want
& to replace it. .
4
4 The definition is replaced with a one-element list.

Select the first cell and enter the first value. Each trme you
press the return  key at the bottom of the list, an additional
cell is added to the list.

ables together to perform a multiway parametric analysis.

If a list element k a text string or label, remember to
enclose it in single quotes. You can enter any kind of num-
ber. function. or exoression as an element of a list. \

Up arrow and Down arrow keys will move the cursor up
and down the list. Press the option and refurn keys simul-
taneously to Insert  a cell after the current cell. Press the
delete key once to delete the contents of a cell; press it
twice to remove the cell.

If you try to add or delete an element of a list that is an
index of an edit table, Demos will ask for confirmation that
you want to change the table. lf you click on the Yes but-
ton, Demos will add or remove the corresponding cell, row,
column, or slice of any tables that this list indexes.

20 * Object. Buying price -ELI:
&, ODecisirn Price Units: SK 2
-. . . - -.
- eeir- Eii?T Title: i&ing

iprice 1I . . . . . _-._.- ---.......A
- Description: Tots1 priceofhouee (includtngclodngcosts)b

nq-
Definition: 400K

Replace current definition with a List?

(tancel) [NO] [yeSg

\

mm ObJect.  Buying price mm:
&]uDecisien Price Units: SK

_ .
Title: Buytng

price

Dercriptirn: Total priceofhouw (includingclwiqcmt~)

IEt-



Creating a table
The edit table window shows a table and lets you enter and edit numbers or If the definitiin of a variable is already a table, an Edit Table button will
expressions into each cell of the table. If you want to specify that the defini- appear in the definition. Click on it to see the edit table window (see page
tion of a variable is to be a table, you select Table from the expression 21).
popup menu, just above the definition field. This will work both in an object
window and attribute view. Demos will then ask you to choose which index
variables you want to specify for the table’s dimensions.

lf the definition is not yet a table, first select Table fro f Object l Buying price t pJd

the expression type popup menu above the defi ODecisirn Price Units: SK ;
field. Title: Buylrq

If the variable already has a definition, Demos will ask
you if you want to replace the current definition with a

? table. Clii on the Yes button (unless you change your

2: mind).
03

Demos will now show the Choose Indices window, to
allow you to specify the dimensions of the table
number of indices you choose will determine the number
of dimensions.

Click on an index to select ft. Then click on the Move
button to make it a current index. I n d i c e s  Choose

Current Indices:

The New button is not currently available. tbu should
make sure you create any needed indices before you
create a table. Each index should be defined as a list of
values

After selecting the indices, the edit table window will
appear (see page 21).



Editing a table 21
The edit table window looks very much like the table window (see page 9), If you close an edit table and haven’t yet clicked on the Accept or Revert
but you can add indices and edit the cells directly in the edit table window. buttons, Demos asks you if you want to accept changes before closing the
Although they look similar, it is important to be aware of the difference, since window. Clicking on the Cancel button won’t close the window.
you cannot edit the standard table window.

You open the edit table window by clicking  the on the
Edit Table button in the object window

(see page 6) or in the attribute view (see page 5).

Pressing on this button will display a popup menu

?
from which to select the index that specifies the

rows, instead of the columns, if the
? table has more than one dimension.
CD \

inputs: 0 Howeloca Houselocation
0 HowaAze Howasire

outputs:
1
c
P

Click on the Choose Indices button to add more indices

Click on a cell to select it.

Drag the mouse from one cell to another to
select a rectangular region.

or to increase the number of dimensions. Any new index of
size n will cause the current table to be copied with its cur-
rent values n times, along the new dimension.

\

Press the return  key to accept
this cell and to select the next cell.

Note: To add or delete celts.  rows or cofumns  in a
table, you need to edit (add or delete) the definition of
the corresponding indices. The affected table cells will
then automatically be added or removed.

Remember to put single quotes
(e.g., ‘Low@)  around text values. Click on the Accept button 16 store

You can copy a cell or a range (w two dimensional changes you have made.

rectangular region) of cells from a table. Select the cell

I
Click on the Revert button to

I
discard

changes since opening the window, or since
the last time you cliied on the Accept button.

orregion.ThenchooseCopyfromtheEdit  menu(g-
C). You can paste these into another celt or region.

IIF Object. Buying price *
Decision Price Unit% SK

Title: Buytnp
price

h ~~ -.-.-.-... “.” . . ..--.-..._  .-... - . .._.._..”  ..-...-... _..-ctcription: /fwprlceof house (Including  closing costs)

I Definition------)Edtt Table indexed by Hovselocstion,Hornssize
I

c i t y
_._.._._......_.... I..“. . . . . 1.--.-1-11

Suburbs_....._.......,..........~. .---- -.--- . . . . . . I.
Rural



Adding icons to diagram nodes 22
You can add an icon for any node in a diagram. First, make sure that the dew. This shows a much enlarged space for drawing or editing an icon. You
diagram is in edit mode, and select the node you wish to illustrate (click on can draw or edit the icon one pixel at a time by mouse clicks, or you can
the node). Then select Edit icon from the Edit menu to get the icon win- draw lines il you hold the mouse button down.

m cost analysis E!!EPlZj

Click on the Accept button to Click on the Clear button to clear
copy the icon into the node. the icon (turning all the pixels

Annual :
1spprdstfon  1

Resulting node with icon.
Adjust handles to fit.

,Click on the Revert
button to revert the win-
dow to the original icon
(or to a blank window if
there was no previous
icon 1.

\ Click on a pixel to make
a dark pixel light, or a
light pixel dark. Drag the
mouse to draw a line.



The save file and open file dialog boxes 23
The top dialog box displayed on this page lets you save the project as a file
on disk. You will see this dialog box the first time you try to save a model by
selecting Saue from the File menu (8-S).  and whenever you select Saue
as from the File menu.

The bottom dialog box displayed on this page lets you open a file to read it
in as the project, or to add it to the currently open project. If the file contains
any objects with the same names as objects in the current project, and you
want to ovetwrite the existing objects with the attributes of the objects from

the file without any warnings, then click on the Updating Module check
box. This option is useful if the file contains updates or modifications to cre-
ate a different version of the project.

If you clii on the Open as text check box, Demos will instead show you
the file as text, and will not add the file to the project. This will let you inspect
or edit the project as a text file. See page 29 for more information. We do
not recommend this procedure for users other than Demos experts.

?
E2 This is the name of the file in,

which the model is to be saved.
Click In this field to edit the file
name.

Click  in the Open as text check
box to open the doarment in a

,

text editing window rather than\
adding the document to the
project.

t3 Demos folder v 0 Release

Save ProJect House as:

Open Document and Add to ProJect:

0 Release

u Open as text Updating Module

/
Don’t save the model by clicking
on the Cancel button.

- Click on the Save button to save
the model using current options.

Clii in the Updatlng Module check box to allow the docu-
ment to redeclare existing objects and redefine existing attributes.



Preferences dialog box
The preferences dialog box allows you to inspect and set a variety of prefer-
ences  for the operation of Demos. It controls how Demos does probabilistic

Select Preferences (X-B) from the Edit menu to see this dialog box. Any

evaluation, the sample size it uses, whether it defaults to a table or graphs,
changed values will be saved along with your model when you save it .

and so on.

Sample Size: enter the number of
runs for the model to oerform to estimate

Sampling method: the items in this box repre-
sent different ways of generating random values
from a probability distribution. Demos provides
standard Monte Carlo simulation and two variants
of Latin Hypercube sampling (see Section 9.7 of
the Demos User’s Manual for details).

\
probability distributions. Larger samples
will take more time and memory to com-
pute, but produce smoother distributions

0
and more precise statistics.

E
Iu

Windows for each Kind: when you
create a new object window Demos will
close an existing object window (if any) if
One only is chosen, unless you press
the Command key as you create the new
window. tt Any Number is selected, it

\will not reuse or close  a window unless
you close it explicitly by clicking in its
close box.

\Automatic Renamlng: click in the Use
f i r s t check box it you want Demos to
automatically rename a variable when\
you change its title. Demos will use up to
the specified characters (10 by default,
from 2 to 20), replacing spaces and
returns with _ (underscore).’

I
The Number width field
controls the maximum number

\ Default value view determines whether a I of characters used in display-
ing a number.

table or graph appears initially when using the

\

uncertainty view selector options to open i
value window.

\ \
1 Preferences t !2

I

I

I

Check variable types:
click in this box if you want
Demos to report when a varf-
able’s value is inconsistent
with its class (see Chapter 7 of
the Demos Users Manual).

151 Check vorhblr tgprr /

/

Check value bounds:
click in this box if you want
Demos to compute any check
attributes.

USI first ~char~ of tit10

A Ask before renominp

- Show undefined: click in
this box if you want Demos to
fill undefined nodes with a
gray border

\

Click in the Ask before renaming/ -.
E,f OK A

chedc box if you want Demos to ask you
for confirmation before tt renames the
variable.

Show model hierarchy:
clicking  on this box shows a
bar at the top of diagram win-
dows to indicate hierarchy

Click on the Ca‘ncel  button to Cliikon the OK button to
ignore any changes and to revert

depth and other navigation
accept changes. options.

to previous settings.



Graph setup dialog box 25
The graph setup dialog box allows you to override the default view ranges Ybu display this box by selecting the Graph Setup from the Graph menu.
for the x and y axes, change the default size of the graph, and to choose You can also display it by double clicking in a graph window. If you open
whether or not to select a three dimensional perspective view. this box when a graph is the active window, the parameters will apply only

to that graph. Otherwise they will be the new defaults for all new graphs.

Click in the Frame AXIS MlnlMax
Values check box to control whethe
the frame ranges on the axes are com-
puted automatically. You must uncheck
this box before you can edit the mini-
mum and maximum fields for each
axis.

O Click in the 30Dimensional check
I box to show the graph in a three dimen-
E sional perspectfve  view. This feature is

not working well yet.

 Graph Setup ’

\$I
Frrme .-.- Y.- ,Y--

-
+J 3-Dimcnrirnal

P

You can enter the initial default
helght and wldth of the graph

/

view as shown on the screen mea-
sured in pixels (72 per inch). You
can later resize a graph with its
growbox.

Note: Small numbers are inter-
preted as inches for compatibility
with earlier versions of Demos.

Click in the Display Key box to
show the Key (for two or more dimen-
sions).

L Click in the Syles  button to dis-
play the graph styles dialog  box
(see page 26).

Enter the y axis maximum value in this
field. . Enter the x axis maximum value in

this field.
This field determines the number of
intervals between tide marks along the
y axis.

- Click on the Apply button to
apply the current setting to the cur-
rent graph.

This ffefd determines the y axis mfni-
mum value. I \ \ Click  on the Set Default button

Enter the x axis minimum This field determines the num- to accept changed values for the
ralue in this field. ber of intervals between tick current graphs and all MureClick on the Cancel button to close

the box, leaving values as they were
before.

marks along the x axis. graphs.



Graph styles dialog box 26
The graph styles dialog box allows  you to inspect and change the style
parameters for a graph, or the defaults for all graphs. You get this box by

If you open this window when a graph is the active window, the parameters

selecting Graph Styles from the Graph menu, or from cliing on the
will apply only to that graph. Otherwise they will be the defaults for all new

Styles button in the graph setup dialog box.
graphs.

The Grid box allows you to control
whether the grit is comprised of dots
or lines. I

Line Style: set the line, sym-
/bol, dot and bar chart styles for

TheTIck  Marks box controls how-
the tick marks appear along the axes:

None: display no tick rnarksH
Min Axes Only: display tick/

marks along the bottom and
left hand axes.

Min and Max Axes: display /
tick marks all around the frame.
Show Numbers: clii in this/

box if you would like numbers
to be shown along the axes.

Frame: controls whether the graph/
displays the axes or a frame around it.

Clickon  the Cancel button to close-
the box and keep the original settings.

/ the graphs.

These two styles show a symbol
at each plot point. Enter the
desired size of the symbols in
typographic points in the S y m -

Hia end tlex Axes

Shov Numbers

Grid: t
0 None
@ .;i’:‘:

0 :::::. . . . .
0 ..+++..

1 Distributien
Resolution

J T”

r Font Style: 
1 Size:l/ Font:[ Helvctice~1

fTGi--)

/
bol Size box.

/
Distribution Resolu-
t ion. when displaying a proba-
bility distribution such as a Pdf
or Cdf, the samples are sorted
into n intervals. The number of
intervals used is calculated from
the sample size divided by the
distribution resolution. Increase
the distribution resolution to pm-
duce a smoother curve.

\ When Equal Prob Steps is
checked, an equal number of
values is used for each interval

’ plot point in a Pdl or Cdf. If it is/
Click  on the Set Default Clii on-the Apply button
button to accept changed val-

not checked, Demos uses equal
to apply the current setting

ues for the current graphs to the current graph.
x interval steps in the range of

and all future graphs.
values being pbtted.



Graph 3D effects dialog box 27
This dialog box controls the point of view for perspective display of three dialog box (when it is displayed in a three dimensional view). Three dimen-
dimensional graphs. Mu can display it by selecting 3D E If ec t s in the sional graphs are not working properly yet, and we do not recummend using
Graph menu, or by clicking on the 3D Effects button in the graph setup them..

The Depth fiikl  allows you to control
the apparenl distance and, hence, the
relative size of the front and back planes
of the graph.

The Pan field allows you to control the
rotation of the graph around a vertical
axis (y-axis).

The Ti I t field  gives you control over
the rotation  of the graph around a hori-
zontal axis (x-axis).

The Rotation field allows you to con-
trol the rotation of Ihe graph around an
axis going into the graph (z-axis).

Graph 30 Effects * -
- -

/The  Flip box allows you to
determine whether or not to
transpose the positive direction
of each axis. Clicking in the
radii button transposes the
positive direction of the axis
listed.

Set Default ]
\

\
Click on the Set Default button
to accept  changed values for the
current graphs and all future
graphs.

- Click on the Apply button to
apply the current setting to the
current graph..



Typescript window 28
The typescript window provides an old-fashioned teletype-style interface to manipulation, and menu options in other windows. The typescript window
Demos, familiar to those who have used non-graphical user interfaces. You contains a record of recent changes, operations, and error messages that
can type commands on the last line after the prompt. Demos prints its are sometimes useful for debugging unexpected behavior. Expert users
response below. Choose Show Typescript from the Window menu to may occasionally find it useful.
see this window.

Choose Hide Typescript from the Window menu to make it go away
Most users will not need to use the typescrii  window. Almost all its features again.
are available more conveniently via buttons, text fields, direct graphic

This icon is highlighted while Demos
is responding to a command.

The name of the project,
or main model.

The total number of objects in
this project including variables,

Demos’ response to a
previous command.

<

A  p rompt  by  Demo<

models, and functions.

f Demos Typescript ’

hl ts: ‘t&or
oescription:  Tha  rmt OWIUOI  Ited dlffet-mce between bqing and ranting a
house, Including nmything I con think of.
kfinltion: Am-profit  - RnnualJmure
Location: 328,128
Nodesite: 40,36
Ulndstate:  1,503,199

A command typed in by the user.



Demos model document 29
A Demos model is saved between sessions as one or more model files. A Making changes to this document will have no effect on the current model
model file is simply a text document. You can examine and edit any model unless and until it is closed and read in using the Read in option from the
file file, including the file from which the current model was started, or the File menu.
file into which it was last saved. You do this by clicking the Open as text
check box in the file open dialog box. You can also create a new text document with the New Text option in the

File menu. This can be useful for making notes on the model.

This is a standard Macintosh text edit-
ing window. Click anywhere to place
the editing cursor, or drag the mouse to
select text. The name of the text file

I

Each Demos object (dedsion, m-i-/
able, model, function) is specified by its
class and name, followed by a list of
user-specified attrfbutes.

Description: Total priC8 of m (including  closing costs)
hfinltlon: flOOK,4OOK~
Locotlon:  48,ea
Nodesize:  32,20

,This  high hyphen indicates that the
attribute value continues on the next
line.

This field shows the location and size,
in pixels, of the node in its parent dia-
gram window.



Find dialog boxes 30
This facility allows you to search a text document for a particular text string,
e.g., to find a particular variable by name, or to search through the project
for a particular obj. To display this box, select Find from the Edit menu
beF).

Type the string you are looking for in
this fiekf. F Find

Clii in the Case sensitive check
box to have the search match the string\
by case, as well.

Clii to the Cancel button to cancel

Case sensitiue

- Click in the Reverse Find
*wbox to search the file backwards rrom

the cursor position.
thiS

- Click orMM-W& button to initiate a
the search. search.

object you are looking for in this field. ’

Presently, you can only search by iden-
tifier, but the ability to search by title is
a feature that will be added.

Click on the Cancel button tb close
the window without starting a search.

! Find !

Tind Demos ObJect?

l
⌧

bh Identi f ier  O’litle
1

[F’ndj- Click on the Find button to initiate a
tj search.



Memory usage and changing memory size 31
The memory usage window gives information about how much RAM mem-
ory the project is using, and the number of objects and sample size that
affect it. This window appears automatically when Demos runs bw on mem-
ory. To display k at other times, select  Memory Usage from the UJindow
menu.

If you run bw on memory, and your Macintosh has sufficient RAM available,
you can increase the memory assigned to Demos. The RAM Memory ini-
tially assigned to Demos fs 1500 Kilobytes (1.5 Megabytes) in the regular
version (Mac II, Mac SE or other machine with a FPU). If your Macintosh
has more RAM available, you can increase the RAM allocated to Demos.

In order to find out how nnrch memory your system requires, select About
thls Macintosh (About the Finder for system 6 and earlier) from the
finder’s Apple menu. Then size Demos accordingly.

If your Macintosh is running operating system 7, you can use virtual mem-
ory, and assign more memory to Demos than you have RAM available. This
will allow you to run larger models but may reduce the speed of Demos
noticeably.

You can change the initial suggested memory size
in the standard Macintosh way, as follows:

1. Make sure Demos is not currently running.
2. Select the Demos application by single click

ing on it to highlight it. (Not a double click
which would start to run Demos.)

3. Select the Get Info (X-I) option from the
F I le menu. Thfs will display the Info box for.-,
Demos.

4. Enter the amount of memory, in kilobytes, to _
be assigned to Demos. This is the maximum
it can use.

5. Close the Info window.
6. Start up Demos in the usual way (see page

1).

PO- Memory Usage

The number of user-defined variables and other ejects. tlemorg  asape  is OK

Current sample size (you might want to reduce‘gsjjii~ /-.Jz&zjT-- .
lt if you are having memory problems).

S h o w s  p r o p o r t i o n  o f  a v a i l a b l e - e i 1
memory currently used.

IIEl-II=-- Demos Info 

Kind : rpplkaUon progam
Sire: 652K on disk (667,S63  bytes us&

Vhoro  : R&as,  : Demos foldu  :

Cr~~t~d:V~,Apr1,1992,11:38AM
Ptodified:  Wed, Apr 1,1992,11:39 AM
Version : Z.Ob3 CPU (US) @ bqrll  t 992

Comments  :
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The diagram style dialog box lets you control various aspects of how a dia-
gram is displayed. It lets you control the font style and size for the node
labels, whether arrows are displayed for specified node types, and whether
the background should be gray (on a monitor that can show grayscales or
colors). You can display this dialog box by selecting Diagram style from
the Diagram menu. The Diagram menu is available only when the dia-
gram is in edil mode.

The node style dialog box lets you control how a node is displayed in a dia-
gram. It lets you specify the font style and size, and whether to display the
incoming arrows, outgoing arrows, the node outline, icon, or label. The
options for each node will override the defaults specified for the entire dia-
gram. To change the node style, you must first select a node in edit mode.

Turn on or off the dlsplay of arrows
into and out of index variables, func-’

tions,  and submodels.

 Diagram Style Lt

Set the font style for all of the,
nodes in the diagram.

Click on the Cancel button
to discard any changes..

Turn on or off dfsplay of input
arrows, output arrows, label.

(title), border, and icon.

Set the font style for the selected,
node in the diagram.

Click on the Cancel button to-
discard any changes.

Then select Node style from the Diagram menu.The other menu
options in the Diagram menu help you create tidy, clearly arranged dia-
grams. When the grid is on (the default) each node you create or move will
be centered on a grid point. This makes it easier to position nodes so that
the arrows are exactly horizontal or vertical when the nodes are side by
side, or one above the other. If nodes get inexplicably off center, the Align
to grid command in the Diagram menu may help adjust the selected
node(s).

Adjust to text in the Diagram menu will change the size,of  the
selected node(s) so that they just enclose the node label.

Node Style

b Ditplep:
Ixi Input l rrovs q  Label
q  Output arrow R Border

q  Ic o n

Use Dieqrrm Font @ Use Crstem Fort

Helvetice

-Set backg round  color
behind nodes to white or
gray

Click on the OK button to
- accept changes.

Font Style: use the diagram
- font style, or set a custom font

style for this node.

Clii on the OK button to accept
- changes.
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The F i I e menu contains file opening and saving commands.

Starts a new project.

Opens a previously saved project.

Closes the active window.

Closes the current project.

Saves the current probct to a file, and
each module and library to its file.,

Saves the current module as a new
file. It will prompt for the file

name and its folder.

Saves a copy of the current module/Rsa”e a ‘Opy ‘“*‘*
into a new file, leaving its current file
name for future saves. tt will prompt -’
for the new file name and its folder.

Export...
,.-.---- _  ̂.__._ -...“̂ -...““-.-l

file into the current view. ,  Page Setup...
Print . . . 8BP

-..““..” .-.-- -““.---..
Displays a dialog box in which you can
select paper size, orientation  and other
printing options.

8BQ’

Creates a new text file.

Opens a saved library or module and
adds it to the current project.

Imports the contents of a text or data

 Exports the contents of the current
view into a file.

Quits the Demos application program.
It will ask if you want to save any
changes.

Displays a dialog box in which you can/
specify the number of copies you want
to print and other prfnting  options.
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The Edit menu contains commands to manipulate text or graphics, find a
Demos object, display the Preferences dialog, and other options.

Cuts the selected text, nodes, graph
or table cells into clipboard tempo-

Undoes your last action. Copies the selected text, nodes,

Selects all text, nodes, or table cells.

Copies the entire multidimensional
value as a tab-delimited list of tables.

-_.-__ . . . . -.--.“I

Pastes the contents of the clipboard
after the cursor or replaces the cur-

Deletes selected text or node.

Opens a window to edit the icon fo
the selected node.

%fW
Displays viafog  box to examine or
change the sampling method, num-

ber of samples, number format
and other preferences.

Fiind Selection
-...-“-.“...“......--.........-

Preferences... %B

Displays a dialog box to find text or a
node by its name-

Finds the previously found text again.
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The 0 b Je c t menu ontains Demos object commands.

Shows the currently selected object in
an object window.

Deletes the selected object.

Creates an alias for the selected obiect.
An alias is a reference to the original

object. You can move the alias
node into a submodel.

Moves the selected object from the cur-
rent diagram to its parent diagram.

-- M a k e  A l i a s Creates an Index and Chance variable
, Moue Into Parent for the selected variable to compute the..____. _..“..___-_  .---. __“”

Importance... ’
uncertainty importance (rank correla-

Show Ualuesl tion) contributions of Is inputs.
.--_“.“-  . . . . - . . . . . . -..-- . . . . ---...

‘Select to show the values of the vari-
able and all its inputs.

Each node in this diagram Is labeled by
the objects title. Select this item to 

Open the Diagram for the selected
model.

show by name (identifier).
Open the Browser window to examine
the model hierarchy and the objects in
each model.



Displays dialog box to specify the
defaull size and frame of view for
the graph.

Displays a dialog box to specify
the style for drawing graphs.

Displays a dialog box to specify 3-
D effects for graphs.

/

Displays a list of the standard mathemati-
cal functions available.

Displays a list of functions for creating and
transforming arrays.

Displays functions for specifying probability
distributions.

Displays special functions available in
Demos.

Statistical
Operators 1-A Displays statistical functions available in
System Uarlables ). ?emos.

Graph and Library menus 36
The Graph menu contains commands for changing the setup and style of The Libray menu lists builf-in system function libraries, as well as any
graphs. libraries of user-defined functions that are currently open. If you are editing

a definition, selecting a function pastes the function name and parameter
types at the insertion point.

\ Displays a list of arithmetic, comparison,
logical, and conditional operators.

Displays a list of System variables which
you can use in definitions.
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The Diagram menu contains mmmands  for changing the display of dia- The Window menu contains commands for btinging  windows to front, or
gram arrows, fonts, and other diagram editing commands. opening special windows.

Shows diagram attributes which you can change.
Diagram Style...
Node Style... I

Shows node attnies which you can change.

Turn Grtct Off

Aligns selected nodes to the diagram grid.

Adjusts the selected node’s size to fit text label.

- Shows or hides the twescriti window.
I.

y Brings a wk~Iow to front.
Bring to Front

Show Memory Usage -/
Displays a window showing memory usage.

Show Cllpboard Shows the contents of the clipboard in a window.

Show Page Breaks  -p Shows page breaks for the currently acthre view.
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The following are all legal formats for entering numbers:

EXAMPLES

Integers: 2,10, 1234

Decimals:

Character exponent:

32.5, .0002,0.000012345

250K, lOSM,  10.5m,  22%

Exponential form: 53El1,l E20, 4.5632E-25

The signed integer after the E denotes a power of ten.
The character after the number denotes a power of ten, thus:

Power Power
0110 Pref Ix 0110 Preflx

3 K Kilo -2 % . percent
6 M Mega or Million -3 m milli
9 6
9 G

12 T
15 Q

Billion
Giga
Tera or Trillion
Quad

-6 u micro (mu)
-9 n nano
-12 p pica
-15 f femto

Range: Demos can represent numbers from about lose to 1 Oe30.
Precision: The maximum precision of numbers is up to the 6th decimal
place. The actual precision may be less if, for example, the number is com-
puted as a small difference between two almost equal numbers.

Syntax: The arithmetic expression
l/2*3-3”2+4

is interpreted as
(1 / 2) l 3) - (3 A 2) + 4

The expression
Ifaandb>cord+e<fAg thenxelsey+z

is interpreted as
If ((a and (b>c)) or ((d+e) < (fhg)))  then x else (y + z)

Pages39 through 45 describe the operators and system functions available
in Demos.
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Operators and functions often expect to work on expressions or values of a
particular type. These symbols represent what type they expect:

x, Y An expression that gives a number, or an array of
numbers.

u. v An expression that gtves  a number or text string, or
an array of numbers or text strings.

b, c An expression that gives a boolean value true (1)
or false (0), or an array of boolean values. Any
non-zero number Is treated as true.

Iam kn expression that yields an array of numbers.

iti, k
V

m, s, r

The name of an index variable.
The name of a variable.
An expression that yields a single number (a
scalar), not an array.

a The name of an attribute.

Arlthmetlc  operator9

Operator Meaning Examples
+ Plus 3+2 -P 5
- mires 3-2 + 1
. times 3’2 + 3X2+ 6

I divided by 3/2 -) g 3 1.5

I A to the power of 13”2 + 32 + 9 I

Comparison operators

I~Operetor I Meaning 7 Examples

<-

P
I

equal to
I

100=101 3 0
‘AB’=‘ab’ 3 0

>= greater than or equal to lOO>=l + 1
‘ab’>=W 3  0

greater than

not equal to

1>2 -NO
‘a*>‘A’ 3 1
102 3 1
‘A’O’B’ 3 1

Loglcal operators

I NOT b true i f  b Is f a l s e ,  NOT(2<3) + 0
otherwise false I I

IF bTHEN x ELSE y
For values of b that are true, x is returned: for values of b that are false,
y is returned.



Math functions

.

40

Abs( x)
This returns the absolute value of x.

Arctan(  x)
This returns the Arctangent of x in degrees. For example, remembering
the venerable trigonometric identity, Tan(x) - Sin(x)/Cos(x), we get:
Arctan(Sin(l2.34)/Cos(  12.34)) + 12.34.

-s(x)
This returns the Cosine of x, in degrees.

Exp(x)
This returns the exponential of x, i.e., ex.

Factorial ( x)
This returns the factorial of x, whkh must be positive or zero.

o h(x)
I

G:
This returns the natural iogarithm of x. Hence, Ln( Exp(12.34)) + 12.34.

a3

Logten ( x )
This returns the kg to the base 10 of x. Hence, Logten(lOV2.34) +
12.34.

Round ( x )
This returns the round value of x to the nearest integer. For example,
Round(l.8) 3 2, and Round(l.499) I) 1.

Sln( x)
This returns the Sine of x, x assumed in degrees.

SW xl
This returns the square of x.

Sqfl(x)
This returns the square root of x, which must be positive or zero. For
example, Sqr(Sqrt(  12.34)) + 12.34.



.
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You can use the List and Table options in the expression type popup to
specify simple arrays and tables. Use the Expresslon optbn in the popup
to use [ ] (list brackets), and Array0  and Table0 functions, if you need
more flexibility and control in specifying arrays.

Most array functions accept an expression a that yields an array of
numbers, and an index name 1. The Index name is optional if the array is
one-dimensional. lf a has more than one dimension, the parameter i should
be used to specify the dimension over which to perform the function.

Area
This computes the area under array if across Index i.

?
Army(if,12,...in,y)

%
This assigns a list of indices, if, 12, . . . 1, as the Indices of the array y,
with il as the Index 01 the outermost dimension, 12 as the secondCD outermost, etc. y must have at least n dimensions.

Average ( a, 1)
This returns the mean value of an array, averaged over Index I.

~~b%wJ,~)
This appends array b to array a. If they are multkfimensbnal, then the
Indexes, i and 1 specify the dimensions of a and b respectively which
are to be concatenated. If specified, k is the index of the resulting
dimensbn, and will consist of the vector created by concatenating i and
I-

Cumulate ( a, I)
This returns an Array of the same dimensions as a with each element
being the sum of all the elements of a along dimension I up to and
including the corresponding element of a.

Integrate ( a, i)
This applies the trapezoidal rule of Integration of array a over Index /
and returns the result.

Max( x,i)
This returns the highest valued element of x (lf an array) along a
specified Index L To get the maximum of two numbers, you must
make them into an array: Max( [ a, b ] ). .

Mln ( x, 1)
This returns the lowest valued element(s) of x (if an array) over a
specified Index i. To get the minimum of two numbers, you must make
them into an array: Mln( [ a, b] ).

Normalize ( a, I)
This normalizes array a, such that the values along Index /sum to I.

Product ( a, I)
This returns the product of all the elements of a, along the dimension
indexed by 1, The resulting value has the dimensions of a with i
removed.

Rank ( a, i)
This returns an array of the rank values of a (provided that a is an
array); the lowest value In a has a rank value of 1, the next-lowest has
a rank value of 2, and so on.

Reform ( a, [ II ,i2,  . . . In] )
This reforms a muttidimensbnal array a in a sequence so that index II
is outermost, i2 next outermost and so on. The Indices il, 12, etc., must
he some or all of the Indices of a.

Sequence ( r, s )
This creates a one-dimensional array of successive integers from I to
s. If rand s are not integers, Demos will round them first. If s is
greater than r, the sequence will be increasing. If ris greater than s,
the sequence will be in decreasing order.

Slze( x)
This returns the number of elements of the outermost dimensions of an
array x.
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?
00
0

Slice ( a, 1, x)
This returns the noI value of array a over the dimension indexed by 1. x
must be between 1 and the length of i. x may also be an array of
values, in which case, Demos will return an array of corresponding
values from a.

Sottlndex ( a, 1)
This computes the ranks of a (from smallest to largest value) and
returns the items  of Index lsorted  according to those ranks.

Subscrlpt  ( a, 1, u)
This gives the element of array a for which index I has value u. u must
be one of the values of Index i. u may also be an array of values from
index i, in which case it will produce a corresponding array of resulting
values  from a. (It Is essentially the same as a(Lu],  but it allows a to be
a general expression, instead of restricting it tobe a variable).

Sum( a,i)
This sums array a over the dimension Indexed by Variable i.

Table ( il , 12, . . . In)(ul,u2,  u3,...un?)
This creates an n-dimensional array, Indexed by the Indices il, 12, . . .
In. The number of Indices, n may be 1 or more. The Indices must be
separated by commas and enclosed In parentheses, as shown. The
second set of parameters to Table specify the values that go into the
Array. These are also enclosed In parentheses, and the separating
commas are optional. Each of these values is specified by an
expression u f, ~2, ~3, . . . urn. The number of values required is the
number of elements of the array, m which is the product of the sizes of
all the dimensions. In this list of elements the last Index in is the
innermost, varying most rapidly.

Uncumulate ( a, 1)
This returns an array of the same dimensions as a. The first element
(along I) of the result is the same as the first element of a. Each other
element of the result is the between the corresponding elements of a
and the previous one. It does the opposite of Cumulate. it is like a
discrete differential operator.

[ ul, ~2, ~3, . . . urn]
This list of expressions separated by commas and surrounded by
brackets creates a one-dimensional unindexed array, i.e., a list, whose
values are ul, ~2, u3, . . . urn. When a variable whose definition
contains this kind of expression is computed, the computed array
becomes indexed by the variable itself. Thus, Index variables are
typrCalty defined in this way. This expression is also often used in the
Array function expression parameter.

V[i’U]
Given v, a variable, and brackets enclosing an index variable name
equal to an item value for that Index, this returns the slice or slices of u
along that Index, like the S/ice function. More than one index can be
specified at a time.
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Probabllfty functions

Chancedlst ( u, a, I)
This creates a discrete probability distribution with a vector of values
given in u and their corresponding probabilities given in a vector of
probabilities a.

Cumdlst  ( a, I)
This converts an array a representing cumulating probability values
along Index i into a continuous probability distribution.

Fractlles  ( [ SO,  sf, ~2.  . . . sn ] )
This Is used to specify an arbitrary continuous distribution by a vector
of n+f elements &for i from 0 to n, where sispecifies  the Vnfractile
(quantile) of the distribution. The probability density is assumed
uniform between the specified fractiles in the distribution.

Lognormal ( m, s)
This creates a lognormal dlstributlon  with median m and geometric
standard deviation s.

Nonal ( m, s)
This creates a normal probability distribution where m is the mean and
s is the standard deviation.

Probdlst(a,i)
This converts an array a representing probability den&y values along
Index iinto a continuous probability distributbn.

Uniform ( f, s )
This creates a uniform distribution between values rand s

Statlstlcs functions

Confbands  (x)
This returns probability or “confldencd bands over x, assumed to be
uncertain, for probabilities specffied in System variable Confidences,
which by default is 5%, 25%. 50%, 75% and 95% probability.

Correlation ( x, y )
This returns the correlation from -1 to 1 between the given distributions
x and y, i.e., the degree to which the two distributions are similar,
where -1 means negatively correlated, 0 means no correlation, and 1
means positively correlated.

Getfract (x, y )
This returns the yfh fractile of x, Le., the value which has a probability
yof being greater than x. Demos evaluates x probabilistically. ’

Mean(x)
This returns the mean of x if H’s a probabilistk value. Otherwise it
simply returns x.

A(x)
This returns the mid value of an expression x, I.e. the value where all
probabilistic inputs are replaced by their median values. MM forces
deterministic evaluation in contexts where it would otherwise be
evaluated probabilistkalty.

Rankcorrel  (x, y )
This computes the rank-order correlatbn of x to y, which is the relative
strength of the distribution(s) in x contributing to the uncertainty
distribution(s) in y.

Sample ( x)
This evaluates x probabillstkaily and returns a sample of values from
the distnkutbn  of x in an array Indexed by System Variable Run.

Sdevlatlon  ( x)
This estimates the standard deviation of x from its sample if it is
probabilistic.  If x is not probabilistic, It returns 0.

Vvarlance ( x)
This returns the variance of x ll lt is probabilistic. tf it Isn’t it returns 0. it
is spelled with two Vs so that it has a different abbreviation from
variable”.
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Argmax ( x, i) Llnearlnterp ( i, y, x )
This returns the corresponding value In Index i for which x is maximum.

aOtv

This returns the attribute a of variable v. This is useful for adding units,
titles etc. to table and graph results. Note: Demos does not
automatically recompute variables that use this expression when the
attribute changes.

Cublclnterp ( 1, J$ x)
This returns the natural cubic spline interpolated values of y along
Index I, Interpolating for values of x. Index i must be in increasing
order, and must be an Index of y. For each value of x, this function
finds the nearest two values from i and uses a natural cubic spline
between the corresponding values of y and computes the interpolated

?
value. If x Is below the minimum value for 1, then the y value

8
corresponding to the minlmum  I value is returned; tf x is above the

N maximum value for 1, then the y value corresponding to the maximum i
value is returned.

Dydx( x,y)
This returns the dertvattve  of expression ywith respect to x, evaluated
at current Midvalues. This shows how a small change In x affects y.
The “small change” is 1 OE-6 if x-0, otherwise x/i 0000.

Dynamic ( xl, x2, . . . xn, y)
This performs dynamic simulation, used in the definition of Variables
whose values change over time, and may depend on their own values
at a previous time. Suppose the variable A is assigned the expression.
The first n parameters are expressbns giving the values of A for the
first n Time  periods.  The last parameter y is an expression giving the
value for each subsequent Ttme  period, and which may refer to the
Variable in earlier Time  periods, e.g. il mtght  be em-lJ+Dx.

-*klty ( Y# xl
This computes the percent change in y caused by a 1% change in a
Variable x. It is related to Dydx thus: Elastlcity( y, x ) 3: Dydx( y, x )‘x
1 Y*

This returns linearly interpolated values of.x, given y representing an
arbitrary piecewise linear function. i is an Index of input values in
increasing order. y is an arrayof the corresponding output values for
the function (not necessarily increasing, and may be more than one
dimension). i must be an index of y. x may be probabilistic and/or an
Array. For each value of x, this function finds the nearest two values
from i and interpolates linearly between the corresponding values from
y. If x is less than the first (and smallest) value in i it returns the first
value In y. If x is greater than the last (and largest) value in i it returns
the last value in y.

Sublndex ( x, y, I)
This returns the index value of i corresponding to value y In Array x.
For example, Argmax uses Sublndex( x, Max( x, / ), I) to return the
index value corresponding to the maximum value in x. If y is an array
of values, an array of index values is returned.

Using I:= x Do y
This assigns a temporary variable named I the value of x and then
evaluates y, assumed to be an expression refening  to the temporary
variable 1. I is essentially the same as a user-defined function
parameter. You can optionally specify a parameter type qualifier to I by
adding a colon after the temporary name I, followed by the qualifier
name (see page xx), as, ‘: p.” Demos evaluates evaluates x according
to the parameter type p, You can also optionally specify an Index i to
iterate over slices of x using the kepord In after x, followed by the
Index name, as, ‘In i.” Each slice will be evaluated in y, and the results
will be indexed by 1. You can use this special syntax for simplifying
complex expressions, reducing the computational effort of your model,
and to be able to pass array parameters to functions that require scalar
values.

Whatlf ( y, x, z)
This temporarily replaces the expression z in the definition of variable x
and evaluates the expression y (assumed to be a function of or
dependant on the value of x), returning the result. The original
definition of x is restored following this substitution. l
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A user-defined function node can be created in the diagram window in edit
mode. Use the information on page 13 to create a user-defined function
node, edit its title, and open its object  window.

A function has one or more parameters and its definition can be an
arbitrary expression containing these parameters. Parameters must be
enclosed in parentheses and their names separated by commas.

By default, the expressbns you pass into your function will be evaluated
according to their context, i.e., deterministically  or probabilistically.

ControllIng the eveluatlon  of functions

0
6.1
g

The default qualifier type Is Context, or Expr (the two keywords are
equivalent In Demos). To apply a different parameter type qualifier to a
parameter or parameters:

CJ
0

cl

0

separate qualifiers from parameters by colons, e.g., ( x : Prob )
apply a qualifier to all parameters by using commas to separate the
parameters and placing the qualifier after all the parameters, e.g., (
x,y: Prob)
apply a qualifier to only one parameter by separating  the list using
semicolons, e.g., in the parameter ( x; y : Prob ), the qualifier
Prob only applies to y
separate multiple parameter-qualifier pairs by semi-colons, e.g., ( x
: Indexl;  y : Prob ). II

Function parameter type quallflen

Ascending
Specifies that the parameter should be. a one-dimensional list of
increasing values.

Context, Expr
Default qualifier for user-defined functbns. Demos evalutes  Function
parameters according to their surrounding context unless you apply
specific qualifiers to them. . ’

Detetm
Used if the parameter should always be evaluated deteninlstically.

IndexType
Used if the parameter should always be an index, i.e, a list.

Numeric
Used if a parameter should be a number, or an array of numbers.

Posltlve
Used if a parameter should be a single positive value.

Prob
Used to evaluate the parameter probabilistically (if possible).

Samp
Used to evaluate the parameter probabalistically and checks that it is
one-dimensional (i.e., one array of sample values indexed by Run).

Scalar
Used if a parameter should be a single number (scalar).

Unevaluated
Used if a parameter should not be evaluated, e.g., if it Is an Array of
text strings.

Vector
Used il a paramefe;  should be a single dimension, i.e., a set of scalar
numbers.

ArrayType
Specifies that the parameter should be an Array of one or more
Dimensions.



How arrays work

An array is a collect&n of numbers (or text strings) that can be treated as a
single unit. Arrays are part of what makes Demos such a powerful
modeling language. Operations and functions that work on single numbers
generalize almost effortlessly to work on arrays. In most cases, the
definition of a variable requires no change if you change the dimensions of
the variables on which lt depends. This makes it suprisingly easy to build
models with multldimensbnal array values.

An array can have one or more dimensions (up to 15). A simple number
(scalar) has zero dimensions. Each dimension Is Mentified  by an index, a
one-dimensional array specifying its size or range of values.

You may often want to calculate a model using alternative d&lsions,
categories (or tables) of information, a specified range of values, or

? alternative values for parametric analys1s.A  category or collection of
g alternative values is a dimension or Index, and Is a simple array. Each
fi value In the dimension Is called an item or slice. Page 19 of the Quick

Reference shows you how to create a List.

1990 0%
1991 5%
1992 10%

C&gpry: sequefux: parame tee
states years rah3

Examples of dimensions or indices

limit CO2
limit Methane

decision:
policy

A collection of values that correspond to items in a dimension or dim-
ensions Is table, and is the general form of an array. Page 20 of the Quid<
Reference shows you how to create a Table.

Callfomia 30M limit  CO2 co2-Costs
Pennsylvanla 1 OM llmlt Methane me-Costs
Populafion by state Cost function by policy

Examples of one-dimensional lab/es

What happens when computing  wtth lists  and tables

These pictures Illustrate how various kinds of arrays can be combined
during evaluation of variables.

i i

El = mI
i a

El +r = im
a b

qi +r,= im
a d e

Identity: an Index i i s
equivalent to a Table i
indexed by Itself.
Operating on a List  iand a
scalar r produces a table a
indexed bv i.
Operating on a table a
indexed by i and a scalar r
produces a table b Indexed
by i.
Operating on tables a, b
both indexed by i produces
a table c Indexed by 1.
Operating on a table a
Indexed by I with a table d
indexed by 1 produces a
twodimensbnal result e for
cross-product of i and j.




